Cambridge International School, Nawanshahr
CYCLE 1: World Around Us
(April-May-July)
Syllabus Of Nursery
Language, Communication & Literacy:

Verbal's:

e Me and my body
BODY PRRTS BODY PARTS
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e Concept of (Open/Close; Young and Old)

Concepts
Young old
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Concepts
Open Close
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2. Box ﬁ 2. Mother -~ Grandmother

e Our Five senses (Body parts and Simple Emotions)
e My Family and my home
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» Hygiene (Personal and Surroundings)
1. Barber ﬁ
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Listening:
¢ Phonics Aa to Zz
¢ Rhymes and songs on phonics
e Story based on the themes
o Phonics using the resource book/puppets



Reading:
e Vocabulary related to jolly phonics
e Phonics using flashcards and related vocabulary
e Picture reading using the flashcards
e Sight words (I, She, He)

Speaking:
e Few lines on- About me

5 Things
I Love about Myself
Directions:

Y "Write 5 Things about Yourself in the Notebook”

¢ Rhymes on Five senses/hygiene
e Role play on cleanliness
e Speaking on any one object that is used to keep our body clean
e Add aword. Example: Comb...... Hair; Shoe......... Polish
o Evoke emotions (Eg: Happy, Sad, Angry)
54

1. Happy Face

2. Sad Face

3. Angry Face
e Speaking a sentence on the emotion, children observe in flashcard.
Written:

e Aa-Cc
e Sandpit writing

e Scribbling
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e Round, Flat and Zig-zag strokes
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e Letter weaving
e Standing, Sleeping, Slanting line
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Standing Line 2%
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Sleeping line
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Slanting Line \

e Free hand shapes
e Drawing with a crayon
e Walking on letters activity

General instructions:

e Greet avisitor
e Wiping of hand and nose

e Keeping the water bottle and bags at the right place
e Opening/Closing of the lunch box



e Folding/Using napkin
Numeracy:

e Oral: (0-5)

e Introducing the Number line

My number line

12 3 4 5 6 7 8 9 10

¢ Rhymes on number

e Sequence counting

e Concept of (Hot/Cold; Heavy/Light; Tall/Short; Fat/Thin)
e  What comes after?

e Shape: Circle

e Colours: Red, White, Pink (Mixing Red and White=Pink)
Written:
e Formation of number (0-2)

Art & Craft:
e Using the shape number recognition
e To Draw the object/ figures using basic shapes
e Tearing& Pasting activities
e A collage on all about me/My favourite things

Faveurite Things/Dress/Feod/Color/Toy

My Favourite Dress ' My Favourite Color
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My Favourite Toy My Favourite Food




e My favourite dress/Food/Colour/Toy
e Person I adore

Cooking:
e Biscuit topping

Physical activities:
e Block building

e Throwing ball

e Count and Jump

Experiment: Observing our shadows (Length of shadows during Morning, Afternoon, Evening)
Note: General activities to be followed as per school calendar.



Cambridge International School, Nawanshahr
CYCLE 2: Animal World
(July-August-September)
Nursery Syllabus
Language, Communication & Literacy:
Listening:
e Rhymes
e Phonics sounds of letter
Speaking:
e Rhymes
e Speaking sounds of the letters with jolly phonics Aa-Zz
e Pronunciation
Reading:
e Read and understand the phonic sounds

Reading of the two letter words (am, an, ap, en, id, ip, ob, od, ab, ac, ad)
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Sight words (is, are, it)

Story related fo the animals
Concepts of (big/small; long/short; more/less; one/many)
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Written:



e Dd-Kk
e Phonic dictation
e Writing the beginning letter of the word
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Activities-Reading activity, knowing/learning words by joining the letters to make a new
word.

General instructions:

e Taking care of the belongings

Taking Care of my
Belongings

e Awareness about the cleanliness

GLEANLIIVESS

e Sensitivity of animals



Knowledge of the world around us:

Verbal:

e Farm animals (Cow, Goat,Hen, Pig, Buffalo, Horse, Sheep, Duck)

Buffalo Horse
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e Sounds and babies of the animals-
e Cat-mew-kitten



Written:
e Worksheets related to the theme

Activities:
e Animal game, tracing, making animal mask

e Paper folding activity (making a bird)
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e Clay moulding
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Numeracy:
Oral- (0-7
e Number line

My number line
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e Recognition of the numbers

e Discriminate and separate the numbers
Written: (0-7)

e Number line
Complete the pattern

What comes after?

What Number,
Comes After?

More/less
Count and match

Count and match
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5o ©

W - 6
Wws - -0
8




e Sequence writings of the numbers

o Estimation and directions (IefT/r'lghT top/bottom; high/low)

e Shape recognition- Square & Triangle

e Colors- Red, Blue, Purple, (Mixing red & blue= purple)

Cooking:
e Chocolate teddy bear cookies

Art & Craft:
. Tear' & Paste
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e Drawing the animal figures using shapes circle and square



Physical activities:

¢ Threading the coloured macaroni

e Animal race
e Cycling



e Catching a ball
e Square game
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Experiment:Data analysis of the animal you like (Class data)

Note: General activities to be followed as per school calendar.



Cambridge International School, Nawanshahr
CYCLE 3: Plant Kingdom
(October-November-December)
Nursery Syllabus
Language, Communication & Literacy:
Reading:
e Vocabulary related to jolly phonics (Aa to Zz)
e Picture reading using the flashcards
¢ Reading of the two letter words (eg, ed, id, ig, if)
e Sight words (a, you, we, are)
Listening:
e Phonics
e Rhymes and songs on phonics
e Story based on the themes
¢ Phonics using the resource book/puppets
Speaking:
¢ Few lines on- Fruits and Vegetables
e Rhymes on Fruits/Vegetables/Flowers
e Role play on Vendor

e Story telling: Views from the students
e Healthy/Unhealthy food

JUNK HEALTHY
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e Scribbling

e Letter Weaving

e Free hand drawing of shapes
e Drawing with a crayon

e Walking on the letters

General instructions:

e Soil digging

e Watering the plants
¢ Using the magic words (Excuse me, Thank you)
Knowledge of the world around us:

e Parts of plant: Roots, Stem, Branches, Leaves, Bud and Flower

Flower
Leaf

o Vegetables: Onion, Potato, Tomato, Carrot, Brinjal



e Worksheets/Games to understand the concept

Numeracy:
Oral- (0-15)

e Number line

e Sequence counting

e  What comes After/Before?

e Backward counting

e Rhymes on numbers

o Concept of (Big/Small, Hot/Cold, Heavy/Light, Hard/Soft, Float/Sink)
e Pattern based on the themes

e Shape: Triangle

e Colors: Red, Yellow, Orange (Mixing Red and Yellow= Orange)

e Calendar: Days of the week

Written:
e Number : 0-15
e Worksheets on shapes and Color
e  What comes after/Before (0-10)
Art & Craft:
e Shape number recognition
e Drawing shapes/objectsusing the basic shapes
e Flower/Shapes

¢ Free hand painting
Physical activities:

¢ Running, jumping and climbing activities
x
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. Ball bouncing activities



e Walking in circles

Cooking:
¢ Making of Fruits and vegetables salad
Experiment: Observe the taste of different fruits

Note: General activities to be followed as per school calendar.



Cambridge International School, Nawanshahr
CYCLE 4: Transport
(December-March)
Nursery Syllabus
Language, Communication & Literacy:
Listening:
e Stories
e Rhymes
e Sounds of the lefters
Speaking:
e Small sentences
e Rhymes
e Recapitulation of sounds of the letters (Tt-Zz)
e Concepts of (Float/Sink, Slow/Fast, New/Old)

Eloat(#Sink!

Reading:
e To read the letters and their sounds

¢ Reading of the two letter words (at, et, in, og, on, ot)
Written:

o Tt-Zz

e Sequence writing of letters

e Dictation

e Writing the beginning sounds of the word

e Complete the sequence by filling the missing letters

A | B DJ E
00 0000 000000 60

H | K | L
000000000000 00 00

Using letter cards to form new words
Sight words (the, this, that)
Knowledge of the world around us:

e To make them aware about the means of transport
e Land Transport: Car, Bus, Cycle, Scooter, Motorcycle



Land Transport

e Water Transport: Ship, Boat, Yatch
Water Tmnsport

e Air Transport: Aeroplane, Helicopter, Hot air balloon
Air Transport

b

e Slow and Fast moving Vehicles

General instructions:
 Making queues to board the bus

o e
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e Playing safely

e Obeying traffic lights while travelling
Stop bo

Numeracy:
Awareness of:

¢ Oral Counting (0-30)
e Number line




e Number recognition

e Dodging

e Sequencing the number from big to small and from small to big

e Colors: Blue, Yellow, Green (Mixing Blue and Yellow= Green)
Written (0-20):

e Sequence writing

o Circle the correct number

e Joining the dots and shapes

e Shape: RecTangleE

e Count and Match

e Complete the pattern

e Count and write the number in front of the object given
e Concept of right and left (Directions)

Art & Craft:
e Show and tell

e Paper folding

e Collage making

e Paper tearing

e Making aeroplane/Boats

Physical activities:

e Hopscotch game

SN




e Snakes and ladders
e Square ball games

Cooking:
e Making a drink for themselves (Tang)
Experiment: Data analysis of the means of transport you have at your home.



Cambridge International School KarihaNawanshahr
Session 2022-23
KG1 Cycle 1(April-May-July)

World around Us

LANGUAGE
Reading/Speaking

> Phonics Aa-Zz

Phonic Sounds _ ==
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Sight Words( I, am, my, he, she, is, a, the, as, if)
Reading from the class board
Introduction of two letter/ three letter words(ab, ad, ed, od, ib)
Introduction of blends( cl, fl, sl)
Vocabulary Words
» Conversation

Listening/ Speaking

» Story (phonics)

> Rhymes/Songs

> Myself (all about me)
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> Woriting (formation)
> Revision A-Z

> Woriting practice of small letters (a-z)

Activities/ Games

> Making Pairs ( first letter sound, birthday months)
> Letter Hunt
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LETTERHUNT

Musical game with phonic sounds
Origami / Clay Modeling

Free Hand Drawing

Matching Uppercase with lowercase

YV V VYV

NUMERACY
Oral
» Concept of O
> Concept of Number-Numeral Relationship
> Concept of Tens and Ones
> Concept of Greater/ Lesser , More/Less

more less

b

> Mental Math (Count and Write)
Listening/ Speaking
> Number Rhyme

I2345 Once 1| Caught A Fish Alve
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One, two, three, four, five,
Once | caught a fish alive,
Six, seven, eight, nine, ten,

- Then | let it go again. 5
Why did you let it go?
Because it bit my finger so.
& Which finger did it bite? ‘3‘@“
= This little finger on my right. =

>  Story (tens and ones)
Writing
» Forward Counting (0-30)
Backward Counting (30-0)
What comes before, after and between (0-20)
Greater/ Lesser (0-20)
Missing Numbers (0-30)
> Number Line (0-10)
Activities/ Games
> Climbing up/ Down the Stairs (counting)
> Alligator Game (<>=)
> Hop on the Number

YV V V V
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EVs
Reading / Speaking
» Names of the Human Body Parts

BEDY PRRUS

i

=
»—fo—m

S
1

stomach

toa —

<@ -

> Sense Organs
» Talk about family, friends, school and surroundings)
Listening/ Speaking
» Story
> Rhymes
» Good Touch/ bad Touch

Good Touch Bad Touch

BE AWARE, NOT ALL
TOUCHES ARE GOOD

> Oral Hygiene

> Safety (School, Home and Bus)
Vocabulary

> Reading from board, body parts, my family)
Writing/ Recoginition

> Body Parts & Sense Organs ( Worksheet)

5 SENSES

Sense of Sight

Sense of Sound g Sense of Taste

T

i




Activities / Games
> Blind Fold( hear, taste, smell, feel)
> Simon says touch your Body Parts
» Origami ( fish,tulip,cap)

vou e

> Activities Exploring Five Senses
> Lets Know our School
> Smokeless Cooking ( lemonade, Sandwich)

> Flash Card Game
> Observe the Hospital ( creating scene of hospital in school: Roleplay)

PHYSICAL
» Catching and Throwing of Ball

> Yoga



Cambridge International School KarihaNawanshahr
Session 2022-23
KG1 Cycle 2 (July- September)

Animal World

LANGUAGE
Reading/Speaking

> Revision of Phonics and Blends done in Cycle 1
» Sight Words( this, that, in, on, under, with, for ,he, she, am, my, I)
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Reading from the class board
Introduction of two letter/ three letter words
Introduction of blends( br,cr, fr, gr)
Vocabulary Words
General Conversation
Use of a/an
> Framing Short Sentences( Verbally)

Listening/ Speaking

» Story : The Lion and the Mouse
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> Rhymes/Songs
> Concept of big/small

>  tall/short

A

TALL SHORT
> Introduction of simple sentences with CVC Words



Writing (formation)
» Revision A-Z
» Formation of a-z
» CVC Words( at, et, it, ot)
> Joining of two letter and three letter words

Activities/ Games

> Picture Cards ( matching with letter and CVC Words)
> Word Basket
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» Word Puzzle ( Word Searching)
> Origami / Clay Modelling
> Colouring and Painting

NUMERACY

Oral (Listening/ Speaking)
> Concept of Shapes Around You
> Concept of Tens and Ones
> Mental Math (Count and Match)
> Number Rhyme

Writing
» Forward Counting (0-40)
Backward Counting (40-0)
What comes before, after and between (0-30)
Greater/ Lesser (0-30)
Number Line (10-20)
Introduction to concept of Addition with objects( Verbal and Pictures)
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> Estimation ( height/weight)
Activities/ Games
> Ladder Game(understand the concept of number line)

> Number card game for the concept of before/after
> Flash Card Game (shapes/numbers)

YV VV V VY
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> Segregating objects of different shapes

EVs
Reading / Speaking
> Names of Pet, Farm and Wild Animals

» Talk about their babies, habitat, sounds and eating habits

Listening/ Speaking
> Recorded Sounds of Animals
> Rhymes
» Few lines on Animals
» Vocabulary ( dog, cat, hen, pig, sheep, cow, wolf, fox, lion, bear, deer)
> Reading from board/ books

Writing/ Recoginition
» Names of Pet, Farm and Wild Animals

Activities / Games

> Recognize the Animal ( Recorded Sounds)
> Place the flashcard of animal to the correct vocabulary
» Origami ( dog, cat and lion)

L a4

Paper Lion

> Enactment

> Differentiate farm and wild animals and place them in their respective habitat
> Smokeless Cooking

> Jungle Party

> Can I make Puppets?

> Let's make a Bird Feeder
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IRD TEEDERS
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PHYSICAL
» Jogging and Stretching
> Playing with Frisbee

General Activities of Cycle 1 as per the school calendar
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Cambridge International School KarihaNawanshahr
Session 2022-23
KG1 Cycle 3(October- December)

Plants

LANGUAGE
Reading/Speaking

» Phonics Aa-Zz

> Sight Words (has, have, but, be, me,and, of, to, the, we, you)
> Reading from the class board

» Introduction of blends( st, sp, ee, oo, er, or)

» Vocabulary Words

> Conversation

» Use of This/That, a/an

f B "EThis is a cat

> Picture Talk

Picture Talk
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Listening/ Speaking

» Story (phonics)

> Rhymes/Songs

> Simple Sentences with CVC Words
Writing
Writing practice of CVC Words (an, un, in, en)

Activities/ Games

> Vocabulary Game
> Word Basket
» Treasure Hunt ( Word Searching)

» 6rid ( Search the Word)



» Odd One Out ( CVC Words) through worksheets
> Word train/ Jumble words

NUMERACY
Oral
> Concept of Shapes Around us.
> Concept of Size and Capacity
> Concept of Tens and Ones
> Mental Math (Same or Different)

Listening/ Speaking

> Number Rhyme
>  Story (tens and ones)
Writing
» Forward Counting (0-50)
» Backward Counting (50-0)
» What comes before, after and between (0-40)

> Greater/ Lesser (0-40)
> Concept of Addition ( mind and finger concept)
> Estimation

Activities/ Games

» Flash Card game

» Ladder game

> Segregating objects of Different Shapes



> Drawing different objects using different Shapes

EVS
Reading / Writing
» Parts of a Plant

Basic Parts
of a Plant

> Names of Fruit and Vegetables

FRUITS
ﬁVEGETABLES #

A NV

> Flowers Name
Listening/ Speaking
» Parts of a Plant
> Importance of Plants
» Food of Plant
» Talking about Living and Non Living things
Activities / Games
> Nature Walk
Vegetable Printing
Fruit Week
Origami ( tulip, carrot)
Enactment
Germination of Seeds ( Class Activity)

L a
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> Projects (germination, trees, Things we get from Plants)
> Smokeless Cooking ( lemonade, Sandwich)



> Flash Card Game

PHYSICAL
> Simple Race
> Hurdle Race

> Balancing Race

7

% General Activities of Cycle 1 as per the school calendar



Cambridge International School KarihaNawanshahr
Session 2022-23
K61 Cycle 4(December- March)

Transport

LANGUAGE
Reading/Speaking

Y

Phonics Aa-Zz
Sight Words ( Revision)

Blends(bl,cl,fl,sl,pl, br,cr,fr,tr, st, sp, ee, oo, er, or)
Vocabulary Words

Awareness of has/have

Picture Composition

Introduction of Diagraphs ( ch, sh..)

Use of This/That, a/an

Picture Talk

YV VVVVVYVYVYY

> Conversation
> Reading From Board/ books)
Listening/ Speaking
> Story
> Rhymes/Songs
> Simple Sentences with CVC Words

1. The bug is red.
2. T like my pet.

3. My pet is wet.
4. I see a cat.

5. Can I go?

6. See my car!

7. I like to bat.

8. The box is wet.
9. My mum can run.

10. T can see a cub.

Writing
> Woriting practice of CVC Words
> Formation of Sentences

Activities/ Games

» 6rid ( Search the Word)



» Odd One Out ( CVC Words) through worksheets

NUMERACY
Oral (Listening/ Speaking)
> Revision of Shapes
» Concept of Size and Capacity
> Concept of Tens and Ones
> Mental Maths
Writing
» Forward Counting (0-60)
» Backward Counting (60-0)
> What comes before, after and between (0-50)
> Greater/ Lesser (0-50)
> Concept of Addition ( single digit)
Activities/ Games
> Number Card game
> Free Hand Drawing
> Making of vehicles with Different Shapes

EVs
Speaking/Reading
> Names of different Modes of Transport
Listening/ Speaking
> Rhymes and Story on Transport
> Names of different Modes of Transport

> Importance and uses of Transport
> Talking about Safety Rules/ Traffic Signs
> Role of Traffic Light and Zebra Crossings
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> Importance and Uses of First Aid Box
Writing
> Names of different Modes of Transport
® Land: car, bus, van, jeep,truck, train
® Water: boat,ship
® Air: jet, helicopter,air balloon, aeroplane
> Days of the week
> Colours Name
Activities / Games
> Making Vehicles with different boxes
Treasure Hunt
I will make racing track ( small group activity)
Free Hand Drawing
Train Game
Making First Aid Box ( group activity)

VV YV VY
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> Common Road Signs
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TWOWay  poadwork  Tumright mp  Roundabout
traffic ahead
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n/\/\/\h

> Project Simulations
> Smokeless Cooking
> Enactment
PHYSICAL
> Kicking, Bouncing and Throwing of Ball
> Warm up excercises
» PT (Physical Training)
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% General Activities of Cycle 1 as per the school calendar



Cambridge International School
Cycle - 1 (April/May/June)
Theme: World Around Us

KG-2

Lanquage/Vocabulary

Reading/Speaking

e Sight Words

e Reading from board/passages/books
o Diagraphs/Blends (ch,sh,00,ee,ing)

e Picture Talk

Listening/Speaking

e Story (with sounds and vocabulary)
e Rhymes
e Conversation with teachers/classmates

®) dreamstime.com

Writing

e Revision of concepts already covered in KG -1
e Use of this/that; is/am;a/an

e Vocabulary

e Framing Sentences

Activities/Games

e Sight Word Chart



e Games with this/that ; a/an
e Name Game (Using Blends,diagraphs)

Numeracy

Reading/Speaking

¢ Number Reading 1(one) O(zero)= 10 (ten)
e Number Names (not in phonics)
e Colours

Yellow White

e Mental Math
e Concepts

Listening/Speaking

e Number Rhymes
e Story (for Mental Math)

Writing
e Revision of concepts already covered
e Counting 0-60
e Concepts before/after/between (0-60)
e Missing Numbers 0-60

e Backward Counting 60-0
e Comparison of Numbers 0-60

s less than

e Mental Math 0-10
e Number Name 0-10
e Basic Shapes/Colour



Square Circle

Rectangle

Addition (Single digit)

Activities/Games

EVS

Number Game 0-60
Jumping on numbers written on the floor (backward counting)
Drawing of more/less things

1||,| |l‘ hiy

Making of Number Line
Guess the colour

Speaking/Reading

Awareness about our country

Recognition/Roles of the Family Members

Framing of Sentences with the vocabulary of Cycle 1
Small Story

People who help me (Helpers)

Listening/Speaking

Rhymes on body parts/family members.



e Story on Hygiene
e Few Lines on My Family (Role Play)
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e Few Lines on Keeping body clean
e Importance of Body Parts and my Family.

Writing

e My body Parts

forak

e My Family Members
e Sentences (for the same)
e Sense Organs



5 SENSES

o Sense of Sight O

Sense of Sound Sense of Taste
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Sense of Smell » Sense of Touch

e Uses of parts of body and sense Organs

Activities/Games

e Helping Mother
e Making of Family Tree

VectorStock

e Good Deed:I will help my friend.

e Blind Folding Game (My Body)

e Tasting, Feeling, Hearing, Smelling, Seeing concepts with games.
o Estimation of Height, Weight.

Hindi*w=wat -3



Cambridge International School
Cycle - 2 (July/August/September)
Theme: Animal World
KG-2

Lanquages/Vocabulary

Reading/Speaking

e Sight Words

e Reading from board/Passages/books

o Diagraphs/Blends (as per vocabulary) Ph,ight,ea,o0a,all
e Short Passages

Listening/Speaking

e Story
e Rhymes
e Conversation with teacher/Class mates

®) dJdreamstime.com

e Simple Sentences
Writing

e Revision of Concepts

e Use of these/thosehas ;are
e Vocabulary Words

e Framing Sentences



e One -Many

Activities/Games

e Sight Word Chart
e Picture Talk
¢ Floor Games relating to Vocabulary

Numeracy

Reading/ Speaking

e Numbers (0-19)
¢ Number Names (not in phonics)
e Colours

Yellow White

¢ Mental Math
e Concepts

Listening/Speaking

¢ Number Rhymes
e Story (for mental math)

Writing

e Revision of concepts already covered.



e Counting (0-70)

e Concepts before/after/between (0-70)
e Missing Numbers (0-70)

e Backward Counting (70-0)

e Comparison of numbers (0-70)

e Mental Math (0-10)

e Number Names (0-19)

o All basic Shapes &Colours

e Addition (Double Digit)

Activities/Games

e Making sets of 2,4,6,8

e Cutting and Pasting of the shapes
e Drawing big/Small Objects

e Number Train

EVS

Speaking/Reading

o Differentiating between Wild/Pet/Domestic Animals
e Sentence reading using new Vocabulary Words

Listening/Speaking

e How are animals are useful to us?

e How does pollution affect the water life?
e Food Chain

e Stories on different animals

e Animal Quiz

e Awareness about protecting them.

e Interdependence of man and animals.

e Life without animals.

Writing

e Pet, Domestic and Wild Animals
e Animals and their babies.

e Animals and their sounds

e Animals and its type.

e Animals and their homes.



e Things we get from animals.

Activities/Games

e Animal Race

e Making different animals with clay.
¢ Colouring/Painting

e Origami

Emotional & Social

e To be sensitive towards animals.
e How/Why should we keep pets?
e Extinct Animals

e Why animals in cages?

e Hindi:
o T - W




Cambridge International School

Cycle - 3 (October/November/December)

Theme: Plants
KG-2

Lanquage/Vocabulary

Reading/ Speaking:

*Sight Words
*Reading from board/passages/books
*Diagraphs/blends/trigraphs

*Conversation with teacher/class mates

*Vocabulary related to the theme

Listening/ Speaking:

*Story (with sounds & vocabulary)

*Rhymes (vocabulary words)

*Picture Talk

Writing:

*Revision of concepts already covered
*Placement/usage of in,on,under

*Framing sentence using vocabulary/sight words

*Opposites



*Picture Composition

Numeracy

Reading/ Speaking:

*Number reading e.g (1(one) O (zero) 10 (ten)
*Number Names (not in phonics)
*Colours/shapes

*Mental math

Listening/ Speaking:

*Number Rhymes

*Story (for mental math)

Writing:

*Revision of concepts already covered.
*Counting (0-80)

*Concepts before /after/between (0-80)
*Missing Numbers (0-80)

*Backward Counting (80-0)

*Comparison of numbers (0-80)

= —

B jraarer LL s \:.’.j."l‘li to
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*Mental math (0-20)



*Number names (20-29)

*Shapes/colours

Sguare CSircle

Triarmele Rectamnsle

*Addition (double digit) without borrow
*Subtraction (single digit)

*Properties of Circle and Triangle

Source: Puzzle Games on Unsplash

Activities/Games

*Dinosaur train (Addition)

*Free hand drawing

*Making of Number line

*Making of flowers with different shapes

*Barney's shapes matching (worksheet)

EVS

Speaking/Reading:




*Names of different types of plants
*Framing sentence using the vocabulary

*Small story using Language (Plants)

Listening/ Speaking

*Rhymes on plants

*Germination of Seed (Activity)

*Few lines on child's favorite fruit, vegetable, flower (any one)

o) FLOWERS - 1 o

= J
<

*Importance of plants and trees

Writing

*Plant Kingdom



*Parts , uses and food of Plant

flower
fruit

stem leaf

roots

*Sentences/flow charts (for the same)

*Names of fruits & vegetables



*Natural and man made

Natural

Man Made

*Living and Non living Things



LIVING THING NONLIVING THING

Mango 7
Our O ' wer Of India
4% National B
Fruit

*Seasonal fruit and Vegetables- Worksheet (sorting)

Activities/Games

*Green Day (Nature walk )

*Making of tree (paper mache)
*Good Deeds : Lets save tree (rally)
*Sharing Day: fruit/vegetable salad
*Being a plant and showing its growth

*Clay modeling (parts of plant)



*Grow more trees







Cambridge International School
Cycle - 4: (January/February/March)
Theme: Water
KG-2

Lanquage/Vocabulary

Reading/ Speaking:

*Sight Words
*Reading from board/passages/books
*Diagraphs/blends/trigraphs

*Conversation with teacher/class mates

Listening/ Speaking:

*Story

*Rhymes

Writing:

*Picture Composition
*Picture Comprehension
*Vocabulary Words
*Framing sentences

*Word building

Activities/ Games




*Dumb Charade

*Action Words game

Numeracy

Reading/ Speaking:

*Numbers (0-100)

*Number Names (nhot in Phonics)
*Colours

*Mental math

*Concepts

Listening/ Speaking:

*Number Rhymes

*Story (for mental math)

Writing:

*Revision of concepts already covered.
*Counting (0-100)

*Concepts before /after/between (0-100)
*Missing Numbers (0-100)

*Backward Counting (100-0)
*Comparison of numbers (0-100)
*Mental math (0-30)

*Number names (30-39)

*Basic shapes/colours

*Addition (double digit) without borrow
*Subtraction

*Days of the week



*Months of the year

*Web of Square & Rectangle

Activities/ Games

*Free hand drawing

*Concept of heavy and light

*Full/Half/Empty
EVS

Speaking/Reading:

Small reading paragraphs based on the new and previous vocabulary.

How rain occurs?

E\,aporation

Why water is useful for us

Listening/ Speaking

*Rhymes

*Save Water, Save Electricity



Save EHlectricity

*Importance of Water

*Life without Water

Writing

*Forms of water

LQuio

*Uses of water
*Sources of water

R

Sources of water




*Web Diagrams

Activities/Games

*Soluble and insoluble
*Float and Sink
*Experimentation

*Water has no shape
ICT

Understanding/Practical Awareness

e Rules of the Lab

e Switch on/off the computer
e Parts of Computers

¢ How the Computer Works?
e Typing of Letters.

e Paintbrush (Shape:Circle)

Activity

e Animated Tutorial
e Paint and fill in the colour

Hindi:
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CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022-2023)
SUBJECT - ENGLISH
CLASS - |

April- August

October- December

COURSE BOOK | 1. Meet my Family (Reading) 1. The Rabbit and the Turtle
2. Off to School 2. Picnic in the Woods
3. Making New Friends 3. The New Watchman
4. Let Us Have Lunch 4. Brave Debby
5. Thank You! (Reading) 5. Come, Let Us Play! (Reading)
6. Wake Up Time (Poem) 6. Save Each Drop (Poem)
7. The Shell (Poem) 7. Ice Cream Time (Poem)
ENRICHMENT » Animal Sounds » A Greedy Rich Man
READER > The Ant and the Dove > The Man Who Saved the Moon
» The Pails of Milk » The Two Brothers
» Jankie the Rabbit » Mangoes
» Ding Dong! » Five Little Ladybirds
WORKBOOK 1. Meet my Family 1. The Rabbit and the Turtle
2. Off to School 2. Picnic in the Woods
3. Making New Friends 3. The New Watchman
4. Let Us Have Lunch 4. Brave Debby
5. Thank You! 5. Come, Let Us Play!




SKILL Listening Skills Listening Skills

e Listens to English words, greeting, polite form of expressions e Listens to English words, greeting, polite form of expressions
and responds. and responds.

e To listen to instructions and draw a picture. e To listen to instructions and draw a picture.

e To understand simple English words and sentences spoken in e To understand simple English words and sentences spoken in
their immediate environment. their immediate environment.

Speaking Skills Speaking Skills

e Recite poems, says dialogues, phrases from stories/plays, etc. | Recite poems, says dialogues, phrases from stories/plays, etc.

e Talk about Self/ Situations/pictures. e Talk about Self/ Situations/pictures.

e Speaks few sentences describing familiar objects and places e Speaks few sentences describing familiar objects and places
such as park, family photograph. such as park, family photograph.

Reading Skills Reading Skills

e Develop phonemic awareness through activities focusingon e Develop phonemic awareness through activities focusing on
different sounds, emerging from the words in stories and different sounds, emerging from the words in stories and
texts. texts.

e Responds orally to comprehension questions related to ¢ Responds orally to comprehension questions related to
stories/poems. stories/poems.

e Understand the text and locate the details. e Understand the text and locate the details.

Writing Skills Writing Skills

e Drawing attention to the use of capital letters and punctuation je¢ Drawing attention to the use of capital letters and punctuation
marks such as full stop, comma, question mark, etc. marks such as full stop, comma, question mark, etc.

e Write simple words and sentences. e Write simple words and sentences.

e Draw and scribble pictures and images from the story as e Draw and scribble pictures and images from the story as
preliminary to writing. preliminary to writing.

WRITINGS e Picture Composition e Picture Composition

e Paragraph Writing




GRAMMAR e Nouns e Describing Words
e One & Many e Opposites
e Atrticles (a,an,the) e Punctuation (Capital letters, Full Stop, Question Mark)
e Helping Verbs (is, am, are, has, have) e Action Words
e Pronouns (he, she, it, I, you, they, we) e Preposition (in, on, under, between, behind, near)
e Tenses (Simple-Present, Past)
ASSESSMENTS 1Al 1A2
v PPT (MAY 2021) (Topics/Chapters) v PPT (NOVEMBER 2021) (Topics/Chapters)
1. Unseen Comprehension 1. Unseen Comprehension
2. Picture Composition 2. Picture Composition
3. Nouns 3. Describing words
4. One/ Many 4. Opposites
5. L-2 (Off to School) 5. L-5 (The Rabbit and the Turtle)
6. Poem- Save Each Drop
v’ Activities for Assessment v" Activities for Assessment
1. Speaking (Describe the picture) 1. Poem Recitation
2. Listening Poem- Five Little Ladybirds (Enrichment Reader)
3. Reading (Enrichment Reader) 2. Listening

3. Reading (Enrichment Reader)




SYLLABUS FOR

HALF YEARLY ( September 2021) (Topics/Chapters)

EXAMS

Reading
Unseen Comprehension/Poem Comprehension

Writing
e Picture Composition

Grammar

e Atrticles

e Helping verbs
e Pronouns

Course Book

1. L-3 (Making New Friends)
2. L-4 (Let Us Have Lunch)
3. Poem — The Shell

ANNUAL EXAM ( MARCH 2022) (Topics/Chapters)

Reading
Unseen Comprehension/Poem Comprehension

Writing
e Paragraph Writing

Grammar
e Tenses
e prepositions
e Punctuation

Course Book

1. L-7 (The New Watchman)
2. L-9 (Brave Debby)

3. Poem — Ice Cream Time




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-23)
SUBJECT - MATHEMATICS

CLASS - |
April- August October-February

CONTENTS % Numbers < Multiplication

% Addition < Money

% Subtraction % Measurement

%+ Shapes and Patterns +«+ Division

% Time +«+ Data Handling

% Mental Maths % Mental Maths

+«+ Revision of four operations: addition, subtraction,
multiplication and division

SUBTOPICS NUMBERS UPTO 100 MULTIPLICATION

/7
A X4

X/
X4

L)

5

S

X/
X4

L)

e

*

X/
X4

L)

e

*

K/
°e

7
L X4

Dealing with numbers (0 to 100)
Counting Before ,After, Between
Comparison (greater ,smaller, equal to )
Ascending Order ,Descending Order
Number names (0- 100)

Expanded form / Standard form
Representing numbers on abacus

Skip counting of 2's, 3's, 5's and 10's
Developing tables of 2, 3, 4 and 5

ADDITION

7
L X4

*
°e

e

*

X/
X4

L)

%

%

K/
L X4

Addition by counting forward

Addition on number line

Addition of zero and one

Addition of 2-digit numbers

Addition of 1 — 2 digit numbers by with and without
regrouping

Daily life situations

¢+ Multiplication by dividing into equal groups.
< Multiplication by repeated addition.
<+ Multiplication by 0 & 1.
%+ Multiplication Tables (2 - 7)
<+ Multiplication of 1-2 digit numbers by single digit
(without carry)
+¢+ Daily life situation problems.
+ Dodging of tables ( 2- 7)
MONEY
Facts related to money
Identification of coins and currency notes.
Counting given amount of money.
Adding given amount of money.
Subtraction given amount of money.
Making Bill
MEASUREMENT
¢ Facts of measurement.
%+ Measuring length using non standard of units
+«¢+ (hand span, foot span, stride)

X3

S

X3

*¢

X3

S

X3

*¢

X3

S

X3

*¢




SUBTRACTION

Subtraction on number line

Subtraction by striking out.

Subtraction by backward counting.

Subtraction of zero from a number.

Subtracting a number from itself.

Vertical Subtraction.

Subtraction of 1- 2 digit numbers ( without borrow)
Daily life Situation problems.

Addition and Subtraction together

*
°e

R/
A X4

X/
X4

L)

e

*

X/
X4

L)

e

*

X/
X4

L)

e

*

X/
°

SHAPES AND PATTERNS

%+ About Plane shapes (Identification and drawing of
shapes)
Straight and curved lines.
Solid shapes (Identification of cone, cylinder, cube,
cuboid and sphere
Concept of plane and curved surface by using rolling and
sliding
Drawing objects by using various lines and shapes.

E
++ Different parts of day
% Reading and telling o'clock time
% Calendar facts (Days of week and months of the year)
% Drawing of o'clocks

X/
X4

L)

e

%

L X4

e

%

Tl

<

7/
*

K/
*

MENTAL MATHS UP TO 250

+«+ Comparing objects on the basis of length ,mass &
capacity( more/less, heavy/light, tall/short)

MENTAL MATHS UPTO 500

DIVISION

+ Division by equal grouping.
++ Division of 1-2 digit no. by single digit (without
remainder)

DATA HANDLING

¢+ Concept of Data
+ Reading and sorting of data.
REVISION OF ALL FOUR BASI PERATION

+«+ Addition of 2-digit numbers without carrying.

¢+ Subtraction of 2 digit numbers without borrowing.

«+ Multiplication of 1- 2 digit numbers by single digit
(without carry)

+¢+ Division of 1-2 digit numbers by single digit (without
remainder)

SKILLS % Number Sense ¢+ Operations related to multiplication & division and their
%+ Operations related to addition, & subtraction and their properties
properties. +«+ Computation
%+ Computation. ¢+ Word problems related to multiplication & Division
%+ Word Problems related to addition & subtraction « Application in daily life (time, money & data handling)
ACTIVITIES % Numbers on Ganit Mala ¢ Repeated Addition

% Addition and Subtraction on Ganit Mala
Shapes and Rangometry Kit/ cut outs of shapes

o
25

s Money (Market Scene)
++ Measurement




¢ Sorting of Different Shapes

+« Equal Sharing

« Time line % Sorting And Reading
ASSESSMENTS 1Al 1A2
s (MAY 2022) (Topi hapter s (NOVEMBER 2022) (Topi hapter
1. Numbers 1.Multiplication
2. Addition 2.Money

s ORALTEST:
1. Mental Maths upto 100
2. Dodging tables (2, 3)

Activities for Assessment
Addition on Ganit Mala (I A-1)
Sorting of Different Shapes
HHW / Notebook

SRR

% ORALTEST:
1. Mental Maths upto 500
2. Dodging tables (2 to 7)

v Activities for Assessment
1 Money (Market Scene for | A-2)
2. Division equal grouping

SYLILABUS FOR
EXAMS

HALF YEARLY (SEPTEMBER 2022) (Topics/Chapters)

1. Numbers
2. Addition
3. Subtraction
4. Time

ANNUAL EXAM (MARCH 2023) (Topics/Chapters)

1.Multiplication
2.Money
3.Division




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022-2023)
SUBJECT-EVS

CLASS-I
April-August October-February
CONTENTS 1. About Myself 1. Food
2. My Body Parts 2. Helpers in Our Neighbourhood
3. My Sense Organs 3. Clothes
4. My Family 4. Houses
5. My School 5. How We Move Around
6. Taking Care of My Body 6. Good Manners and Habits
7. Festivals And Celebrations 7. Fascinating World of Plants
% Annual Project (Knowing My State) 8. Amazing World of Animals
SUBTOPICS » About Myself Food
o More About Myself o Meal times
» My Body Parts o Food we get from plants and
o Body Parts and their functions animals
» My Sense Organs Helpers in our Neighbourhood
o Functions of sense organs o Importance of our helpers
» My Family o Respect everyone’s work
o Meaning of Family Clothes
o Role of Family members o Different seasons demand
o Golden Rules different clothes
» My School o Care of Clothes

o People at School
o Things we learn at school

» Taking Care of My Body

o How to keep yourself clean

> Festivals and Celebrations

Houses
o Types of Houses
o Rooms in my house
How We Move Around
o Different means of Transport

Good Manners and Habits




o Different religious and national

o Healthy and Good Habits

festivals » Fascinating World of Plants
o Types and Uses of Plants
» Amazing World of Animals
o Kinds of Animals
o Homes of Animals
SKILLS » Thinking skill » Thinking skill
» Social Skill » Social Skill
» Emotional Skill » Emotional Skill
» Speaking Skill » Speaking Skill
» Pyscho motor Skill » Pyscho motor Skill
ACTIVITIES » Flashcards » Flash cards
» Collect photographs » Collect and paste
» Draw » Draw
» School visit » Nature walk
» Poster making » Observation
» Group presentation » Role Play
» Poster making
» Group presentation
ASSESSMENTS 1A1 1A 2
< PPT(May 2022) s PPT(NOVEMBER 2022)
1. My Body Parts 1. Food
2. My Family 2. Clothes
3. Amazing World of Plants
% ORAL TEST % ORAL TEST
1. About Myself 1. Helpers in Our Neighbourhood

«» Activities for Assessment
1. My Sense Organs

«» Activities for Assessment
1. Good Manners and Habits




SYLLABUS FOR
EXAMS

HALF YEARLY EXAM September (2022)

1. Taking Care of My Body

2. My School
3. Festivals and Celebrations

ANNUAL EXAM March (2023)

1. Houses
2. How We Move Around
3. Amazing World of Animals




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)
SUBJECT - ICT

CLASS-I
April —August October - February
CONTENTS 1. Computer: A Machine 1. Using the Keyboard
2. Parts of a Computer 2. Data and Memory
3. The Computer Mouse 3. Fun with Tux Paint
4. Fun with Microsoft Paint
SUBTOPICS Computer: A Machine
» Natural and Man-made Things Using the Keyboard
> What is a Machine? > Cursor
» Computer: A Smart Machine > Types of Keys
» Types of Computer > Special Keys
Parts of a Computer
» Main Parts of a Computer Dat;and Memory
Data
» Other Parts of a Computer » Hard Disk
The Computer Mouse > CD and DVD
» Computer Mouse » Pen Drive
> Mouse Pointer > Memory Card
» Actions of Mouse Buttons
Fun with Microsoft Paint Fun with Tux Paint
» Starting MS Paint > Starting Tux Paint
> Parts of the Paint Window > Parts of Tux Paint Window
> Drawing Shapes > Drawing Shapes
> Coloring a Shape » Coloring Shape
> Listening , Critical thinking, Reasoning, » Listening, Critical thinking, Reasoning,
SKILLS Organizing, Presenting, Observation and Organizing, Presenting, Observation and
Problem Solving Problem Solving

ACTIVITIES/LAB

» ldentification of parts of computer » ldentification of Keys




WORK

» Drawing different shapes in MS Paint

>

Drawing different shapes in Tux Paint

ASSESSMENTS
> 1A-1 (Topics/Chapters) s 1A-2 (Topics/Chapters)
Ch-3 Parts of a computer Ch-5 Using the Keyboard
Ch-1 Computer: A Machine Ch-7  Data and Memory
< ORAL TEST(Topic/Chapters) % ORAL TEST(Topic/Chapters)
Ch-1 Computer: A Machine Ch-7  Data and Memory
% LAB Activities for Assessment(Topics/Chapters) * LAB Activities for Assessment
(Topics/Chapters)
Ch-4 The Computer Mouse ] ]
Ch-6 Fun with Microsoft Paint Ch-8  Fun with Tux Paint
SYLLABUS FOR HALF YEARLY EXAM ( September 2022 ) ANNUAL EXAM ( March 2023)
EXAMS (Topics/Chapters) (Topics/Chapters)
1. The Computer Mouse 1. Data and Memory
2. Parts of a computer 2. Using the Keyboard
3. Computer: A Machine 3. Fun with Tux Paint
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - 11

April- August

October- December

COURSE BOOK

1.Goldilocks and the Three Bears
2. The Ant and the Grasshopper
3. What is Pink?

3. The Test

4. Echo

5. My Hat

6. The Spider’s Lesson

1.Down the Rabbit Hole
2.Come little leaves

3.The Day the sun Went Hiding
4. The Hidden Gift

5. The Moon

6. Things are puzzling

7. The Beach

8. Laughing Song

Enrichment > The Lion and the Mouse > The Swing
Reader > The Blue Pot and the Red Pot > The Apple Tree
> The Cupboard > Edward’s Day Out
> The Jackal and the Drum > Hello and Good-by
> The Wind and the Sun > The Magic Sticks
WORKBOOK > Worksheet 1 -5 > Worksheet 6 — 10
SKILL Listening Skills Listening Skills

e To listen to instructions and draw a picture.

e To Listen to stories, and humorous incidents and interact in
e English or home Language.

Speaking Skills

e To sing or recite poems or rhymes with actions.

e To speak English, talk to their peers in English, relating to
festivals and events at homes and schools.

Reading Skills

e To enrich vocabulary in English mainly through telling and
retelling stories/folk tales

e To ask simple questions, for e.g. On characters, places, the

e To listen to instructions and draw a picture.

e To Listen to stories, and humorous incidents and interact in
e English or home Language.

Speaking Skills

e To sing or recite poems or rhymes with actions.

e To speak English, talk to their peers in English, relating to
festivals and events at homes and schools.

Reading Skills

e To enrich vocabulary in English mainly through telling and
retelling stories/folk tales

e To ask simple questions, for e.g. On characters, places, the




sequence of events in the story etc.

e To look at the script in a print rich environment like
newspapers, tickets, posters etc.

Writing Skills

e To compose and write simple, short paragraphs with proper
space between the words

e To write English relating to festivals and events at home and
school.

sequence of events in the story etc.

e To look at the script in a print rich environment like
newspapers, tickets, posters etc.

Writing Skills

e To compose and write simple, short paragraphs with proper
space between the words

e To write English relating to festivals and events at home and
school.

WRITINGS e Picture Composition e Dialogue Completion
e Paragraph Writing e Informal Letter
GRAMMAR e Nouns e Conjunctions (and, but, because, or, so, if )
e Punctuation (Capital letters, Full Stop, Question Mark, e Preposition (between, behind, above, of, up, down, before,
Comma) after, near, about, since, in front of, in, under , beside, on, at,
e Action Verbs in)
e Articles e Tenses (Present, Past and Future- Simple)
e Helping Verbs (is, am, are, was, were, has, have)
e Pronouns
e Adjectives
ASSESSMENTS |IAl 1A2
v PPT (MAY 2022) (Topics/Chapters) v PPT (NOVEMBER 2022) (Topics/Chapters)
1. Unseen Comprehension 1. Unseen Comprehension
2. Poem- My Hat, Chapter- The ant and the Grasshopper 2. Conjunctions, Prepositions
3 Articles, Nouns, Punctuations 3. Dialogue Completion
4 Picture Composition 4. Poem- The Moon, Chapter- The Hidden Gift
v Activities for Assessment v Activities for Assessment
1. Reading — The Blue Pot and the Red Pot (ER) 1. Poem Recitation- The Swing (ER)
2. Listening Activity— The Cupboard (ER) 2. Listening Activity- Hello and Good —By (ER)
3 Goldilocks and the Three Bears(CB) — ORAL 3. The Day the Sun Went Hiding (CB)- Reading+ Listening
4 Echo ( CB)- Reading + Listening 4. Things are Puzzling- Reading + Listening
5. Laughing Song- Poem Recitation (ORAL)




SYLLABUS FOR

HALF YEARLY ( September 2022) (Topics/Chapters)

EXAMS

Reading
Unseen Comprehension

Writing

e Paragraph Writing
Grammar

e Adjectives

e Pronouns
e Helping Verbs (is, am, are, was, were, has, have)

Course Book
1. Poem- What is Pink?
2. Chapter- The Test, The Spider’s Lesson

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

Reading
Unseen Comprehension

Writing
e Informal Letter

Grammar
e Tenses — Present, Past and Future

Course Book
1. Poem- Come Little Leaves
2. Chapter- Down the Rabbit-Hole, The Beach




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT —- MATHEMATICS

CLASS - 11
April- August October-February

CONTENTS s Numbers < Multiplication

% Addition ¢ Division

+ Subtraction % Fraction

% Money % Measurement

% Time + Data Handling

% Shapes and Patterns
SUBTOPICS NUMBERS UPTO 1000 MULTIPLICATION

% Counting

¢+ Write numbers in words and figures ¢+ Multiplication as repeated addition

%+ Expanded Form/ Standard Form <+ Multiplication by grouping

% Representation of Ones, Tens and Hundreds on Abacus ¢+ Multiplication on number line

% Place Value/Face Value <+ Multiplication tables (2-9)

¢+ Comparing numbers( Greater/Smaller) <+ Multiplication facts

¢+ Ordering of Numbers ( Ascending/Descending) ¢+ Multiplication by 10,100

¢+ Successor and Predecessor <+ Multiplication of 2 digit numbers by single digit (with and

+» Before/after/Between without regrouping).

+ Even/Odd Numbers ¢ Dalily life Situations

% Ordinal Numbers DIVISION

¢+ Building 3-digit numbers +¢+ Division by sharing into equal parts.

¢+ Formation of the Greatest and the smallest Number ( ++ Division through pictures by grouping.

With and Without repetition) +¢+ Division by repeated subtraction..
+¢+ Division of 2 digit numbers by a single digit number (
with and Without remainder)
ADDITION +«» Daily life situation
% Addition 3- two digit number (With and Without FRACTIONS
regrouping)
¢ Addition of 3-digit numbers +¢ Introduction of Fraction




¢ Addition of numbers with different digits
% Daily life Situations
% Value based questions
SHAPES & PATTERNS
% Concept of straight & curved lines
% Draw horizontal, vertical & slant line
% Recognition and drawing of plane and solid shapes and
their properties
% Patterns in shapes & figures
SUBTRACTION
++ Subtraction of 2 digit and 3 digit numbers
('With and without regrouping)-
Excluding checking
% Subtraction facts
» Daily life Situations

%+ Value based questions
MONEY
% Reading Money in Rupees and Paise
% Adding Money
%+ Subtracting Money
% Making Bills
¢ Dalily life Situations
TIME
¢ Reading and Telling time(O’clock, quarter past, half past
)
%+ Months of the year, Days of Week
% Reading Calendar

X/
*

X/
*

X/

Write fractions in words

Concept of numerator and denominator
Concept of one half, one-third, quarter
Recognizing different fractions
Fraction of a collection

o
o
o
o
o

MEASUREMENT

Measuring length using scale

Estimating correct unit of measurement.
Estimating objects on the basis of length, mass and
capacity.

++ Drawing of line segment using scale.

DATA HANDLING

X/ X/
LX G Xd

X3

*

¢+ Collecting Data
+ Reading and Drawing of Pictograph

REVISION OF MULTIPLE CONCEPTS

«+ Addition of 3-digit numbers

++ Subtraction of 3 digit numbers

¢+ Multiplication of 2- digit by 1 digit
+¢+ Division of 2- digit by 1 digit number




SKILLS ¢ Number Sense +¢+ Calculation, Problem solving
% Arithmetic operations: |Addition, Subtraction % Arithmetic operations : Multiplication ,Division
%+ Problem Solving <+ Application in daily life: Measurement, Fraction & Data
¢ Application in daily life: Shapes and Patterns , Handling
Money& Time +« Computation
s+ Word Problems related to addition, subtraction « Sorting, planning, analyzing
% Visualization
ACTIVITIES ++ Odd and Even +»+ Fraction
¢+ Shapes with Judo Rangometry Kit ++ Data handling
¢ Sorting of different 3 — D shapes % Measurement
% Bill Making
% Calender Activities
% Time Lines
ASSESSMENTS 1Al 1A2
% (MAY 2022) (Topics/Chapters) % (NOVEMBER 2022) (Topics/Chapters)
1. Numbers 1. Multiplication
2. Addition 2. Data Handling
% ORALTEST % ORALTEST
1. Mental Maths 1. Mental Maths
2. Dodging tables ( 2 to 7) 2. Dodging tables ( 2 to 10)

« Activities for Assessment
1. Shapes with Judo Rangometry Kit ( .A. 1)
2. Homework/Notebooks

« Activities for Assessment

1. Fraction
2. Data Handling
3. Measurement




SYLLABUS
FOR EXAMS

HALF YEARLY ( September 2022) (Topics/Chapters)

1. Subtraction
2. Time
3. Money

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

Division

Data Handling
Fractions
Measurement

NS




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022-2023)
SUBJECT - EVS

CLASS - 11
April — August October — February

CONTENTS 1. My Family 1. My Country

2. My Body 2. Festivals and Celebrations

3. Growing Up 3. Transport

4. Taking Care of Our Body 4. Plants Around Us

5. Ways to Behave 5. The World of Animals

6. Eating Healthy 6. Weather and Seasons

7. Clothes We Wear 7. Sun and Moon

8. Houses We Build 8. Our Home - Earth

9. Safety First 9. Days, Months and Years

10.0ur Neighbourhood

¢+ Annual Project (Celebration of Life)
SUBTOPICS » My Family » My Country

oMembers of Family

o Types of Family
» My Body

oExternal and Internal Parts of Body

o Sense Organs
» Growing Up

o Growth in Human Beings

o Growth in Plants and Animals
» Taking Care of Our Body

o  Healthy Habits

o  Staying away from Germs
» Ways to Behave

o Good Manners

oNational Symbols
» Festivals and Celebrations
o National and Religious Festivals
» Transport
o Different Means of Transport
o Importance of transport
» Plants Around Us
o Types and Parts of Plants
o Uses of Plants
» The World of Animals
o Food of Animals
o Uses and Protection of Animals

> Weather and Seasons




» Eating Healthy
o Kinds and Sources of Food

» Clothes We Wear
o Different Clothes for Different Seasons
o Kinds of Clothes
» Houses We Build
o Types of Houses
o Peoples who help us to build the house
» Safety First
o Safety at Home
o Safety on the Road
» Our Neighbourhood
o Services in the Neighbourhood

o Different Seasons

> Sun and Moon

o Introduction about the Sun, Moon
and Stars
o Man’s Journey into Space

> Our Home - Earth

o Landforms on the Earth
o Waterbodies on the Earth

» Days, Months and years

o Different phases of time
o Introduction of days, months and Years

SKILLS » Thinking Skill » Thinking Skill
» Social Skill » Social Skill
» Emotional Skill » Emotional Skill
» Speaking Skill » Speaking Skill
» Psycho motor Skill » Psycho motor Skill
ACTIVITIES » Flashcards » Flashcards
» Collect photographs, pictures and paste » Collect and Paste
» Draw » Draw
» Poster making » Nature Walk
» Group presentation » Visit
» Role play » Observation
» Role Play
» Poster Making
» Group presentation
ASSESSMENTS IAL I1A2
% PPT (May 2022) s PPT (November 2022)
1. My Family 1. Transport
2. My Body 2. Plants Around Us




% ORAL TEST
1. Taking Care of Our Body
2. Ways to Behave (Reading)

R

«» Activities for Assessment
1. Safety First

<+ ORAL TEST
1. Sun and Moon

«» Activities for Assessment
1. My Country

2. Days, Months and Years

SYLLABUSFOR
EXAMS

HALF YEARLY EXAM (September 2022)

Eating Healthy
Clothes We Wear
Houses We Build
Our Neighbourhood

ronNRE

ANNUAL EXAM (March 2023)

1. The World of Animals

2. Festivals and Celebrations
3. Our Home — Earth

4. Weather and Seasons




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)

SUBJECT - ICT

CLASS- 11
April —August October - February
CONTENTS 1. Computer: A Smart Machine 1. Keyboard
2. Parts of a Computer 2. Handling a Mouse and Touchpad
3. Operating a Computer 3. Microsoft Word
4. More on Tux Paint
SUBTOPICS Computer: A Smart Machine Keyboard

» Difference between Humans and Computers

» Types of Computers

» Uses of Computer at different places

Parts of a Computer

Monitor

CPU

Keyboard

Mouse

Printer

Speakers

Headphones and Microphones
UPS

Hard Disk

CD, DVD and Pen Drive
Operating a Computer

VVVVYVYVVYVYYVYYVY

» Starting a Computer
» Parts of the Desktop
» Shutting down a Computer
>
More on Tux Paint

» Starting a New Drawing

» Symbol Keys
» Special Keys

Handling a Mouse
» Computer Mouse
» Mouse Actions
» Touchpad

Microsoft Word

Starting MS Word 2016

Parts of MS Word 2016 Window
Typing Text in Word

Saving a Document

Closing a Document

Opening a Saved Document
Creating a New Document
Exiting MS Word 2016

VVVVVVVY




» Lines Tool

»  Shapes Tool

» Text Tool

» Magic Tool

» Saving a Drawing

SKILLS » Listening, Critical thinking, Reasoning, Organizing, » Listening, Critical thinking, Reasoning,
Presenting, Self Direction, Observation and Organizing, Presenting, Self Direction,
Problem Solving. Observation and Problem Solving
ACTIVITIES/ » Identification of Parts of Computer » Learning the keyboard keys and memory
LAB WORK » Interface and button identification of desktop icons » Learning the handling of mouse.
» Making a project in Tux Paint using different tools » Making a document in MS Word on Topic “My
Self”
ASSESSMENTS % 1A-1 (Topics/Chapters) % 1A-2 (Topics/Chapters)

Ch-2 Parts of a Computer
Ch-1 Computer: A Smart Machine

% ORAL TEST(Topic/Chapters)

Ch-1 Computer: A Smart Machine

«» LAB Activities for Assessment

(Topics/Chapters)
Ch-3 Operating a Computer (For 1A-1)
Ch-6 More on Tux Paint (For Half- Yearly)

X/
L X4

X/
L X4

Ch-7 Keyboard
Ch-4 Handling a Mouse and Touchpad

ORAL TEST(Topic/Chapters)
Ch-4 Handling a Mouse and Touchpad

LAB Activities for Assessment
(Topics/Chapters)
Ch-4 Handling a Mouse and Touchpad (For IA-

2)

Ch-8 Microsoft Word (For Annual)

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM ( September 2022 )

(Topics/Chapters)

1. Computer: A Smart Machine
2. Parts of a Computer
3. More on Tux Paint

ANNUAL EXAM (March 2023)

(Topics/Chapters)

1.
2.
3.

Keyboard
Handling a Mouse and Touchpad
Microsoft Word
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - 111
April- August October- February

LITERATURE 1. The Ostrich And The Hedgehog 1. Rip Van Winkle
READER 2. The Bird 2. Rabbit And Lark (Poem)

3. I Am APolar Bear (Assessment) 3. Good Neighbours

4. Trip To Heaven 4. The Table And The Chair (Poem)

5. The Secret Song (Poem) 5. APresent For Mother (Assessment)

6. The Blue Whale (Assessment) 6. Jungle Jamboree(Assessment)
COURSE BOOK » The Royal Parade » Juan Bobo’s Pot

» The Story Of Rudolph » Tooth Troubles

»  Williwu Learns To Make Friends » We Save A Whale

» Hachiko » ADay At The Swamp

» Annalisa And The Giant » Something From Nothing
WORKBOOK » Worksheet 1-5 » Worksheet 6-10
SKILL Listening Skills Listening Skills

To listen and respond appropriately to oral messages.

Enrich vocabulary through listening stories.

Speaking Skills

Encourage students to participate in role play and enactments with
appropriate expressions.

To recite poems individually/in groups with correct pronunciation and
intonation.

To present orally the highlights of a narration/given text.

Reading Skills

To read aloud with appropriate pronunciation and pause.

To express opinion/understanding about the text and characters in the
text.

Students will read small text in English with comprehension i.e.
identifies main idea details and sequence and draws conclusions.
Writing Skills

Students will write on personal experiences/ events using verbal or
written clues.

To listen and respond appropriately to oral messages.

Enrich vocabulary through listening stories.

Speaking Skills

Encourage students to participate in role play and enactments with
appropriate expressions.

To recite poems individually/in groups with correct pronunciation and
intonation.

To present orally the highlights of a narration/given text.

Reading Skills

To read aloud with appropriate pronunciation and pause.

To express opinion/understanding about the text and characters in the
text.

Students will read small text in English with comprehension i.e.
identifies main idea details and sequence and draws conclusions.
Writing Skills

Students will write on personal experiences/ events using verbal or
written clues.




To use meaningful sentences in writing incorporating variety of
adjectives, prepositions in context.
To appropriate in writing about occasion/day to day life situations.

To use meaningful sentences in writing incorporating variety of
adjectives, prepositions in context.
To appropriate in writing about occasion/day to day life situations.

WRITINGS . Paragraph . Dialogue Writing
. Dialogue Completion . Story Writing
. Informal Letter . Diary Entry
GRAMMAR . Nouns and its kind . Tenses (Progressive and Perfect- Present, Past and Future)
. Pronouns and its kind . Adjectives (Kinds and degree)
. Conjunctions . Prepositions
. Tenses (Simple-Present, Past and Future) . Articles
ASSESSMENTS |[lAl 1A2
v PPT (MAY 2022) (Topics/Chapters) (4 PPT (NOVEMBER 2022) (Topics/Chapters)
1. Unseen Comprehension 1. Data Interpretation
2. The Bird 2. The Table And The Chair (Poem)
3. Conjunctions 3. Tense (Progressive)
4. Informal Letter 4. Dialogue Writing
(4 Activities for Assessment 4 Activities for Assessment
1. Listening 1. Listening
2. Speaking 2. Speaking
3. Activity 3. Activity
SYLLABUS FOR |HALFE YEARLY ( September 2022) (Topics/Chapters) ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)
EXAMS Reading Reading
Unseen Comprehension/Data Interpretation Unseen Comprehension/Data Interpretation
Writing Writing
. Paragraph . Dialogue Writing
. Dialogue Completion . Story writing
. Informal Letter . Diary Entry
Grammar Grammar
. Nouns and its kind . Tenses (Progressive and Perfect- Present, Past and Future)
. Pronouns and its kind . Adjectives (Kinds and degree)
. Conjunctions . Prepositions
. Tenses (Simple-Present, Past and Future) . Articles
Literature Literature

1. The Ostrich And The Hedgehog
2. Trip To Heaven
3. The Secret Song (Poem)

1. Rip Van Winkle
2. Rabbit And Lark (Poem)
3. Good Neighbours




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-23)
SUBJECT —- MATHEMATICS

CLASS - 111
April- August October-February

CONTENTS 1. Numbers (Upto 10,000) 1. Division

2. Data Handling 2. Fractions

3. Addition 3. Money

4. Subtraction 4. Measurement

5. Multiplication 5. Time

6. Lines, Shapes and Symmetry.

(To be assessed through activity)
SUBTOPICS NUMBERS (UPTO 4 DIGIT NUMBERYS)

%+ Numbers in figures and words (Upto 10000) DIVISION

3

0

Skip Counting
Place value and Face value
Expanded Form and Standard Form
Successor and Predecessor( Before/after/Between)
Comparing and Ordering Numbers
Building Numbers
Ascending and descending order
Rounding off numbers
% Even & Odd Numbers
DATA HANDLING

3

0

3

0

3

0

3

0

5

S

R/
A X4

5

S

% Importance of Data

% Tally marks

“ Reading of tally marks table, pictograph

Drawing of pictographs and tally marks
ADDITION (UPTO 4 - DIGITS)
% Properties of addition .

» Addition of 4 — digit numbers ( with / Without
regrouping)
Application of addition in daily life
Estimating sums

*,

(AR

*,

D)

X3

2S

K/
‘0

)

<
<
<
<

X/
L X4

X/
L X4
X/
L X4
X/
L X4

X/
L X4

X/
¢

3

*

3

*

3

*

X3

%

X/
X4

L)

Division as repeated subtraction

Division as Equal Distribution

Common Properties of division

Division facts( Mental Maths)

Divide and check

Division of 3 — digit numbers by 1,2- digit numbers (till
25) with and without remainder

Division by 10,100 and 1000

Application of division in daily life

FRACTIONS

Concept of Fraction

Write fractions in words

Visualization by drawing figures
Concept of numerator and denominator
Fraction of a Region.

Fraction of a collection

Meaning of Like and Unlike Fractions
Comparison of fractions (like fractions)
Equivalent Fractions

Addition and subtraction of like fractions




% Mental Maths
SUBTRACTION (UPTO 4 - DIGITS)
% Properties of Subtraction
Subtraction of 4 digit numbers with checking
Addition and Subtraction together(Simplification)
Application of Subtraction in daily life
Estimating differences
Mental Maths
MULTIPLICATION
% Conceptual understanding of multiplication(Facts)
% Properties of multiplication
% Multiplication Tables

o
A5

*
°e

X/
X4

L)

X/
X4

L)

X/
X4

L)

X/
X4

L)

X/
*

X/ X/
* *

X/

digit (with / without regrouping)

Multiplication by 10, 100, 1000

Mental Maths

% Application in daily life

LINES, SHAPES AND SYMMETRY
%+ Types of lines

%+ Open and Closed Shapes

Regular and Irregular shapes

Plain and Solid shapes

Symmetry

7/
X4

L)

7/
X4

(AR

*,

3

0

3

0

5

S

% Multiplication of 3 — digit numbers by single and double

X/
L X4

Application of fractions in daily life

MONEY:

X/
o

X/
o

X/
o

X/
o

X3

S

X/
o

7
°e

Concept of Money

Expressing money in figures and words

Concept of Counting Money

Conversion of rupees to paise/ paise to rupees
Mathematical operations on money (add, subtract,
multiply,excluding division)

Application of money in daily life

Making money bills

MEASUREMENT:

X/
°

X/
°

X/
°

X/
L X4

X/
L X4

Facts of length/ mass /capacity

Conversion of larger units to smaller units

(mtocm, Kmtom, Kgtog,Itoml)

Estimation of units

Mathematical operations : addition/ subtraction/
multiplication excluding division using different measures
Word problems

(EXCLUDING:Conversion of smaller units to bigger units)

TIME

X/
L X4

X/
L X4

X/
L X4

X/
L X4
X/
L X4
X/
L X4

X/
L X4

Reading and writing time in exact hours and minutes
Concept of a.m. / p.m.

Time duration(simple/Direct)

Time line

Estimating Time

Calendar reading

Conversions

1. Weeks to days

2. Years to months

3. Days to hours




>

SKILLS %+ Number sense related concepts and computation ¢ Number Sense
% Arithmetic operations: Addition, Subtraction % Computations Skills
% Computation Skills < Application in daily life
% Multiplication and Problem solving + Data interpretation and time
%+ Fraction — Concept and applications
¢ Application in daily life- Measurement
ACTIVITIES % Activity of Data Handling ( Pg. No. 228, 229) ¢+ Time Line (Pg. No. 195)
% Activity of Lines , Shapes and Symmetry(Pg. No0.143) < Bill Making Activity
ASSESSMENTS |1A1 1A2
% (MAY 2022) (Topics/Chapters) (NOVEMBER 2022) (Topics/Chapters)
1. Number upto 10,000 1. Division
2. Data Handling 2. Fractions

>

s ORALTEST:
1 Mental Maths
2. Dodging Tables(2 to 10)
Activities for Assessment:
1. Activity of Data Handling ( Pg. No. 228, 229 )
2.Activity of Lines , Shapes and Symmetry(Pg. No.143)
3. HHW

< ORALTEST:
1 Mental Maths
2. Dodging Tables(2 to 12)
Activities for Assessment
1.Time Line (Pg. No. 195)
2.Bill Making Activity

SYLLABUS FOR

HALF YEARLY EXAM (SEPTEMBER 2022)

EXAMS

1. Numbers

2. Data Handling
3. Addition

4. Subtraction
5. Multiplication

ANNUAL EXAM (MARCH 2023) (Chapters)
1. Division
2. Fractions
3. Money
4. Measurement
5. Time




CAMBRIDGE INTERNATIONAL SCHOOL
SESSION -2022-23

GRADE -1l

SUBJECT-SOCIAL SCIENCE

Services
climate

People, Culture and Food
Buildings, Monuments, Museums and Fairs
Shopping Malls and Amusement Parks

April-August October-February
Contents 1. India: Physical and Political Divisions 1.Transport and Communication
2. National Symbols 2.What we do
3.Environment 3.Mumbai
4.Indian Life style 4.Kolkata
5.Delhi 5.Chennai
¢+ Annual Project(My Identity My Nation)
Sub Topics » India: Physical and Political Divisions » Transport and Communication
e India-Physical and Political Divisions e Transport
and neighbouring countries. e Means of Transport Communication
» National Symbols e Means of communication
National Flag » What we do
National Emblem e Occupation
National Anthem o Different types of occupations and their importance
Other Symbols > Mumbai
> Environment e Location and Government office
e Importance of Environment e Economy, Utility services, Transport Services
e Pollution ' e climate
e Types of Pollution _ e People, Culture and Food
¢ How can we save our environment e Buildings, Monuments, Museums and Fairs
» Indian Life style e Shopping Malls and Amusement Parks
e Food of different regions > Kolkata
e Clothes worn in different Regions e Location and Government office
> DeIh|_ . e Economy, Utility services, Transport Services
e Location and Government office e climate
e Economy, Utility services, Transport .
[
[
>

People, Culture and Food

Chennai




Location and Government office

Economy, Utility services, Transport Services
climate

People, Culture and Food

Buildings, Monuments, Museums and Fairs
Shopping Malls and Amusement Parks

e Buildings, Monuments, Museums and
Fairs
e Shopping Malls and Amusement Parks

Skills » Thinking and Critical thinking skills » Thinking and Critical thinking skills
» Social Skills » Social Skills
» Emotional Skills » Emotional Skills
» Observation » Observation
» Map Skill » Map Skill
Activities » Stone Painting » Search Work
» Search Work » Timeline
» Timeline » Web Diagram
» Web Diagram » Table making
» Table making » Poster making
» Poster making » Group Presentation
» Group Presentation > Role Play
> Role Play » Map Work
» Map Work » Debate
» Debate » Poster Making
» Broacher making




Assessments | 1AL A2
s PPT (May 2022) s PPT(November 2022)
1. National Symbols 1. Transport and communication
2. Environment 2.What We Do
% Oral Test
% Oral Test
1. The Earth
% Activities for Assessments 1. Indian Villages
1. The Universe ¢ Activities for Assessments
2. Holidays H.W 1. Early Humans
Syllabus for Half Yearly Exams(September 2022) Annual Exams (March 2023)
Exams 1. India: Physical and Political Divisions 1.Transport and Communication

2.Indian Life style

3.Delhi

4.National Symbols

Map Work

India: Physical and Political Divisions
e Neighbouring Countries
e Delhi

2.What we do

3.Mumbai

4 Kolkata

5.Chennai

Map Work:
e Mumbai
e Kolkata
e Chennai




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022- 2023)
SUBJECT - SCIENCE

CLASS- 111

April —August

October - February

CONTENTS

1.Food we eat

2.Safety

3.Solid,Liquid and Gases (Activity)
4.Living and Non-Living Things
5.Parts of a Plant

ok wnE

Light,Sound and Force
Weather

Pollution

Our Earth

Our Body

Going into Space(Activity)




SUBTOPICS/CONCEPTS

1.Food we Eat

2.Safety

» Types of food we eat

» Our teeth

» Tooth decay

» Taking care of our teeth

Safety Rules to be followed:-

» At home

» Inclassroom

» While playing on road
» First Aid

3.Solid ,liquid and gases(Activity)

4.Living and Non-Living Things

» Features of living things

» Features of non living things

5.Parts of a Plant

Root

Stem

Leaf

Flower

Fruit

Seed

Functions of each part

YVVVVYVYYYVY

1. Light,Sound and Force
» Luminous and non luminous objects
» Shadow formation
» Sound
» Force and its use

2.Weather
» Weather
» Different seasons
» Weather affects our life

3. Pollution

Types of pollution

Air pollution

Water pollution

Soil pollution

Noise pollution

Pollution in cities and villages

VVVYYY

4. Qur Earth

Shape of the Earth

The Earth’s Neighbours

Movements of Earth-Rotation and Revolution
Sun

Moon

Stars

Constellation,Astronomers.

VVVYVYVYYVYY

5.0ur Body
Parts and uses of the following organ

system

Skeletal system
Muscular system
Digestive system
Respiratory system
Circulatory system
Nervous system
Excretory system
Reproductive system

VVVVVVVY 'V

6.Going into spaces(Activity)




SKILLS e Writing e Observation and application
e Drawing e Kinesthetic skill
e Analysing e Synthesis
[ ] [

Observation and interpretation skills

Communication skill

ACTIVITIES e Creative writing e Flash card preparation
e Role play e Class activity
e Collage making e Role play
ASSESSMENTS 1A-1 1A-11

» PPT (May 2022)

1.Food we eat
2.Living and non-living things

> ORAL TEST(May)

1. Safety

> Activities for Assessment(Topics/Chapters)

1. Solid, Liquid and Gases
2. Holidays Homework

> PPT ( November 2022)

1. Light,Sound and Force
2.\Weather

» ORAL TEST (October)

1. Our Body

> Activities for Assessment (Topics/Chapters)

1.Going into Space

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM (SEPTEMBER 2022)
(Topics/Chapters)

1. Food we Eat
2. Living and Non-Living Things
3.Parts of a Plant

ANNUAL EXAM ( MARCH 2023)
(Topics/Chapters)

1. Light,Sound and Force
2.\Weather

3.Pollution

4.0ur Earth




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022- 2023)

SUBJECT - ICT

CLASS- 111
April —August October - February
CONTENTS 1. Introduction to IPO 1. Operating system
2. Computer devices 2. Introduction to Scratch
3. Working in MS Word 3. Movements of Sprite
SUBTOPICS Introduction to IPO Operating system

» Working of a computer

» Advantages of a computer

» Limitations of a computer
Computer Devices

» Input devices

» Processing device

» Output devices

» Storage devices
Working in MS Word

» Word 2016 Window
Typing Text in a Document
Editing Text

Undo and Redo Commands
Printing a Document
Exiting Word

YVVVYVYVVYVY

>
>
>
>
>
>
>

>

Microsoft Windows

Desktop and its Components
Selecting and Deselecting Icons
Opening an Application

Arranging Desktop Icons

Sorting Desktop Icons

Changing the Desktop Background
Changing the Screen Saver

Introduction to Scratch

More Operations on a Document

>
>
>
>
>
>
>

>

Starting Scratch

Main Components of Scratch

Drag and Drop Blocks in the Script Area
Moving a Sprite

Drawing a colorful Circle

Making a Copy of a Sprite

Saving a project

Opening a saved project

Movements of a Sprite

» Creating a New Project
» Changing the Appearance of a Sprite
» Making a Sprite Say Something




> Control Block Menu
» Adding Sound

SKILLS e Listening, Self-Direction, Critical Thinking, e Self-direction, Leadership, Critical Thinking,
Reasoning, Organizing, Presenting, Observation Reasoning,Inquiry,Observation,Prediction,
and Problem Solving Problem Solving,MentalSkills,Organizing

and Presenting

ACTIVITIES/ LAB e Creating a document in MS-Word, Formatting text e Making a sprite in scratch

WORK on MS-Word Document e Drawing colorful circle

e Changing the appearance of sprite
e Adding sound in Scratch

ASSESSMENTS
» 1A-1 (Topics/Chapters) » 1A-2 (Topics/Chapters)
1.Computer Devices 1. Introduction to Scratch
2. Introduction to IPO 2. Operating System
> ORAL TEST (Topic/Chapters) > ?SAL IESg (TOp'C/ Chapters)
1. Introduction to IPO -operating system
» LAB Activities for Assessment (Topics/Chapters) > LAB.ACt'V't'eS for Assessment
1. Working in MS Word (Topics/Chapters) .
' 1. Movements of a Sprite
SYLLABUS FOR HALF YEARLY EXAM (September 2022) ANNUAL EXAM (March 2023)
EXAMS (Topics/Chapters) (Topics/Chapters)
1. Computer Devices 1. Operating System
2. Working in MS Word 2. Introduction to Scratch

3. Introduction to IPO 3. Movements of a Sprite
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - IV

April- August

October- February

LITERATURE 1. The Nightingale 1. The Rooks (Poem)

READER 2. How The Camel Got His Hump 2. Gemma (Assessment)
3. Dear Mr. Examiner (Poem) 3. The Boy Who Could Not Finish A
4. The Shah Weaves The Rug 4. The Town Mouse And His Country Cousin
5. Racing The Wind (Assessment) 5. Boys Scouts Forever!

COURSE BOOK > Tansen- The Magical Magician > At Least A Fish
> Bambi > Grandpa Fights An Ostrich
> Veena’s New Idea > The Case Of The Candy Bandit
> Mulan > Dr Dolittle Learns A New Language
> Yeti > The Governess

WORKBOOK Worksheet 1-5 Worksheet 6-10

SKILL Listening Skills Listening Skills

Students will listen to and communicate oral messages.
Listen to simple instructions and act accordingly.

Enrich vocabulary through listening stories.

Speaking Skills

Participate in classroom discussions on questions based on day
to day life.

To share their personal experiences/describe places or events
using appropriate vocabulary.

Reading Skills

Students will recite poems with appropriate expression and
intonation.

Students will listen to and communicate oral messages.
Listen to simple instructions and act accordingly.

Enrich vocabulary through listening stories.

Speaking Skills

Participate in classroom discussions on questions based on day
to day life.

To share their personal experiences/describe places or events
using appropriate vocabulary.

Reading Skills

Students will recite poems with appropriate expression and
intonation.




Students will infer the meanings of unfamiliar words by reading
them in context.

Encourage learners to read independently and silently.
Writing Skills

Students will use grammar skills in a contextual and integrated
manner to frame grammatically correct sentences in their
writings.

To understand different forms of writing (informal letter/short
stories/diary entry)

Students will describe briefly in their writing about events,
places or experiences.

Students will infer the meanings of unfamiliar words by
reading them in context.

Encourage learners to read independently and silently.
Writing Skills

Students will use grammar skills in a contextual and integrated
manner to frame grammatically correct sentences in their
writings.

To understand different forms of writing (informal letter/short
stories/diary entry)

Students will describe briefly in their writing about events,
places or experiences.

WRITINGS o Diary Entry o Story Writing
e Informal Letter o Dialogue Writing
e Story Writing e Notice Writing
o Dialogue Writing o Description
GRAMMAR o Tenses e Articles
e Articles e Tenses
e Adjectives e Modals
« Conjunctions e Prepositions
e Prepositions e Infinitives
ASSESSMENTS |1Al 1A2
v PPT (MAY 2022) (Topics/Chapters) v PPT (NOVEMBER 2022) (Topics/Chapters)
1. Unseen Comprehension 1. Data Interpretation
2. How the camel got his hump 2. The Boy who could not finish a
3. Dialogue Writing 3. Infinitives
4. Prepositions 4. Notice Writing
v' Activities for Assessment (Any two) v Activities for Assessment(Any two)
1. Doodling 1. Situational Cards
2. Listening 2. Listening
3. Chart on tenses 3. Picture description




SYLLABUS FOR
EXAMS

HALF YEARLY ( September 2022) (Topics/Chapters)

Reading
Unseen Comprehension/Poem Comprehension/ Data

Interpretation
Writing
e Diary Entry
e Informal Letter
o Story Writing
o Dialogue Writing

Grammar
e Tenses
e Articles

e Adjectives
e Conjunctions
e Prepositions

Literature

1. The Nightingale

2. Dear Mr. Examiner

3. The Shah Weaves The Rug

Long questions can be in the form of Diary Entry,
Paragraph or thinking based questions.

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

Reading
Unseen Comprehension/ Poem Comprehension/ Data

Interpretation
Writing
e Story Writing
o Dialogue Writing
o Notice Writing
e Description

Grammar

e Articles

e Tenses

e Modals

e Prepositions

e Infinitives
Literature

1. The Rooks

2. The Town Mouse And His Country Cousin
3. Boys Scouts Forever!
Long questions can be in the form of Diary Entry,
Paragraph or thinking based questions.




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022 -23)
SUBJECT - MATHEMATICS

CLASS - IV
April- August October-February

CONTENTS 1. Large Numbers 1. Multiples and Factors

2. Roman Numerals 2. Time

3. Addition and Subtraction 3. Perimeter and Area

4. Multiplication 4. Fractions

5. Division 5. Data Handling

6. Money 6. Measurement

7. Plane Figures, Shapes and Patterns

( To be assessed through activity only)

SUBTOPICS LARGE NUMBERS MULTIPLES AND FACTORS

Indian system of numeration.

Writing given number in words & figures.

Expanded notation

Place and Face value

Predecessor & Successor

Comparison of numbers

Ordering of numbers

Building of numbers(by using the given digits)
Rounding off numbers(nearest 10,100,1000)
Excluding International Place Value Chart (Ex. 1.2)

ROMAN NUMERALS

Roman Numerals up to 50.

Roman to Hindu Arabic & Vice Versa
Comparison of Roman Numerals
Completion of Series

Ordering upto 50

Concept of factors and multiples

Common factors and common multiples.

Test of divisibility by 2,3,4,5,6,9,10

Prime and composite number

Prime Factorization by factor tree and division method.
Concept of LCM(using common multiples and long
division)

HCF (using common factors and prime factorization)

Reading of time to exact minute

Concept of a.m and p.m.

Time: 12 hour and 24 hour clock time.

Duration of time

Conversions (hours to minutes, minutes to seconds, days
into hours and vice -versa)

Application in daily life




ADDITION AND SUBTRACTION
e Addition and subtraction with regrouping
e Estimated sum/difference
e Application in daily life.
e Simplification
MULTIPLICATION
e Facts
e Properties of multiplication
e Multiplication of 4 digit numbers by single, two and
three digit numbers
e Multiplication with 10, 100 and 1000
e Multiplication by estimation
Application in daily life
DIVISION FACTS
Division Facts
Division by single and two digit divisors.
Divide and check
Division by 10,100,1000
Application in daily life
Division by estimation Simplification (DMAS)
MONEY
e Conversion of rupees to paise and vice -versa
e Addition and Subtraction of Money
e Application in daily life
PLANE FIGURES, SHAPE AND PATTERNS

e Knowledge of Concept of line, ray, line segments.
e Drawing of line segment

AREA AND PERIMETER

e Concept of perimeter and area
Finding perimeter and area by counting squares
Perimeter of plane figures
Perimeter of rectangle and square using formula
Area by using formula (square and rectangle)
Application in daily life (with figures)

FRACTIONS
e Types of fractions(Unit, proper, improper, mixed ,like
,unlike)
Fraction of a Collection
Conversions(improper to mixed and vice versa)
Concept of equivalent fractions
Reducing fractions to lowest term
Comparison of like/unlike fractions
Ordering of like/unlike fractions
Addition and subtraction of like/unlike fractions
Application in daily life.

DATA CHARTS

e Drawing tally marks

e Reading & Drawing of pictograph

e Reading & Drawing of bar graph

e Reading of pie chart
MEASUREMENT

e Measurement facts

e Conversions(m to cm, km to m, cm to mm, kg to g, g to

mg, KLto L, L to mL & vice -versa)
e Addition and subtraction
e Application in daily life




e Construction of circles using compass
e Concept of radius, diameter, chord , circumference
e Observing the numerical patterns (from Ch -12)
e Patterns
SKILLS e Number sense e Number sense
e Computational skills e Computational skills
e Problem solving e Problem solving
e Application in daily life: geometry e Application
e Arithmetic Operations: addition, subtraction, e Visualisation
multiplication, division e Logical Reasoning
e Data interpretation
ACTIVITIES e Design using circles of various radii e Activity of Divisibility Rules ( Pg .no. 104)

e Currency of Different Countries(Pg. No. 197)

HOTS of Measurement ( Pg..no. 208)

ASSESSMENTS |1A1

v

s (MAY 2022) (Topics/Chapters)
1. Large Numbers
2. Roman Numerals (Upto 50)
% ORAL TEST:-
Mental maths/ Dodging Tables
Activities for Assessment
1. Plane figures, Shapes and Patterns
2. Money
3. HHW

(NOVEMBER 2022) (Topics/Chapters)
Multiples and factors

Time

ORAL TEST:-

Time

Activities for Assessment

Multiples and Factors

Measurement

SYLLABUS FOR

HALF YEARLY ( SEPTEMBER 2022) (Topics/Chapters)

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

EXAMS

1. Large Numbers

2. Addition and Subtraction
3. Multiplication

4. Division

5. Money

1.

Uk wm

Multiples and Factors
Time

Fractions

Perimeter and Area
Data Handling
Measurement




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT -SOCIAL SCIENCE

CLASS-1V
April- August October-February
Content 1. Northern Mountains 1. Indian Desert
2. Northern Plains 2. Plateaus of India
3. Agriculture in India 3. Communication
4. Soll 4. Indian Industries
5. Transport 5. Coastal Regions and Islands of India
6. Water Resources 6. Forest and Wildlife
¢ Annual Project(Agriculture in India)
SUBTOPICS * Northern Mountains *Indian Desert

Himalayan Range

Purvanchal Range

Life in region

Importance of Himalayas

* Northern Plains

Location of the Northern Plains
River basins in the Northern Plains
Life in the Region

Importance of the Northern Plains
* Soail

Types of soil

Soil Erosion

* Transport

Modes of transport

Different types of transport
*Agriculture in India

Meaning of Agriculture

Types of crops

Helping the farme

*Water Resources

Desert Landscape

The Thar Desert

Climate of the Desert

Life in Desert

*Plateaus of India
Peninsular Plateau

Life in Plateau

Importance of Plateaus
*Communication

Types of communication
Uses of Internet
Advertising

*Indian Industries
Requirements of Industries
Types of Industries

Major Industries

Role of Industries
*Coastal Regions and Islands
Coastal Plains and Islands
Life in coastal Plain




Main sources of water
Means of irrigation in India
Multipurpose Projects
Conservation of Forest

Importance of the coastal plain
*Eorest and Wildlife

Types of forest

Conservation of Forest

Thinking skill

e Thinking skill o
SKILLS e Social skill e Social skill

e Emotional skill e Emotional skill

e  Speaking skill e Speaking skill

e Map skill e Map skill

e Reading skill e Reading skill
ACTIVITIES e Flashcards e Flashcards

e Draw e Draw

e Flowchart e Flowchart

e Table making e Table making

e Poster making e Poster making

e Role play e Role play

e Map workz e Map work

e Sample collection e Sample collection

e Collect photographs, pictures and paste e Collect photographs, pictures and paste

e Group presentation e Group presentation

e Reading skill e Reading skill

e Observation e Observation




ASSESSMENTS

1Al
< PPT (May2022)
1. Northern Mountains
< Map Work
(States of Purvanchal and Trans Himalaya)
2.Northern Plains

ORAL TEST

e Unity in Diversity
Activities for Assessment
Our Heritage
Holiday Home Work

1A2

% PPT(November2022)
1. Indian Desert
2.Indian Industries

ORAL TEST

e Human Resources
Activities for Assessment
Mineral Resources

SYLLABUS
FOR EXAMS

HALF YEARLY EXAMS(September2022)
1.Northern Plains

2.Agriculture in India

3.Soil

4. Transport

5.Water Resources

Map Work:
1.The states of Northern Plains

2.State producing wheat, pulses, Jute, cotton, coffee, Tea
(Three states)

ANNUAL EXAMS (2023)
1.Plateaus of India
2.Communication
3.Indian Industries
4.Coastal Regions and Islands of India
5.Forest and Wildlife

Map Work:
The coastal Plains and Islands

Plateaus of India

Indian Desert

Forest and Wild life (National parks, Wildlife
Sanctuaries)




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - SCIENCE

CLASS - IV
April- August October- February
CONTENT 1. Plants-Making food 1. Adaptation in animals
2. Soil 2. Teeth and digestion
3. Clothes and fibres 3. Safety
4. Force, Work and Energy (Activity) 4. Solid, Liquid and Gas
5. Our food 5. Air, Water and weather(Activity)
SUBTOPICS/CO |1.Plants — making foods 1. Adaptation in animals
NCEPTS . ++ Habitat,
% Parts of a leaf, o < Adaptations to habitat,
::: g\/la_kln? foogl, IEnetrgé/ flovxéln Ilvmﬁ tt:rl]ngs, % Adaptation for food,
, S(;“ nimals and plants depend on each other. < Adaptation to be safe.
= 2. Teeth and digestion
% Formation of soil, '? Types and sets of teeth,
% Constituents of soil, types of soil, < Importance of teeth,
% Importance of soil. «» Structure of tooth,
3. Clothes and fibres +«» Care of teeth
3. Safety
«» Sources of fibres, % Safety at home,
+ Clothes and cIirﬁate. ’f Safety on plgyground and road,
+» Rail safety tips,
4.0ur food N .
E— + First aid
“* Nutrients, ] o
< Roughage and water, 4. Solids, liquids and gases
 Balanced diet, % Matter,
% Alertness concerning food, «» States of matter,




% Cooking methods and precautions, ¢ Interchangeable states of matter,
% Methods for preserving food % Solubility.
5.._Force, Work and Energy (Activity) 5.Air, water and weather (Activity)
+» Causes for blowing of Wind,
++ Land breeze and sea breeze,
s Weather,
¢+ Factors affecting rate of evaporation,
+«+ Evaporation, condensation, freezing,
< Water cycle

X3

S

SKILLS ++ Observation

s Communicating
¢ Analyzing

% Inferring

Analyzing
Communicating
Observation
Investigating

X/
°

e

*

X3

S

¢+ Application ¢ Inferring

% Problem Solving %+ Classifying

¢ Evaluating +«+ Evaluating
ACTIVITIES e Report making e Lab activity

e AVR e Role play

e Show and tell e Flash card making

e Role play e Report making
ASSESSMENTS 1Al 1A2

s PPT (MAY 2022) s PPT (NOVEMBER 2022)

1. Soil 1. Teeth and Digestion

2. Our Food 2. Safety

% ORAL TEST (MAY) % ORAL TEST (OCTOBER)

1. Plants —making food

Activities for Assessment

1.Adaptation in Animals

Activities for Assessment




1. Force, Work and Energy 1. Air, Water and Weather
2. Holidays Homework

SYLLABUS FOR |HALF YEARLY EXAM ( September 2022) ANNUAL EXAM ( MARCH 2023)
EXAMS
1. Soil 1. Teeth and digestion
2. Clothes and fibres 2. Safety
3. Our Food 3. Solid, liquid and gas
4. Adaptations in animals




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)

SUBJECT - ICT
CLASS- IV

April —August

October - February

CONTENTS 1. Computer Hardware and Sftware 1. An Introduction to the Internet
2. Computer Memory 2. Introduction to PowerPoint
3. Working with Windows 3. More on PowerPoint
4. Playing with Multiple Sprites

SUBTOPICS Computer Hardware and Software An Introduction to the Internet

» Computer Hardware
» Computer Software
Computer Memory

» Types of Computer Memory
Working with Windows

Windows Desktop

Files and Folders
Windows Explorer
Creating and Saving a File
Creating a Folder
Opening a File/Folder
Renaming a File/Folder
Deleting a File/Folder
Restoring a File/Folder
Copying or moving a File/Folder
Searching Files/Folders

VVVVVVVVYYY

» What is Internet?

» Uses of Internet

» Basic Terms related to Internet

» Opening a Web Browser

» Opening a Website
Introduction to PowerPoint

Uses of a Presentation

Starting MS PowerPoint 2016
Components of MS PowerPoint Window
Creating a Presentation

Adding Text in a Placeholder
Slide Layouts

Inserting Objects in a Slide
Saving a Presentation

Closing a PowerPoint Presentation
Opening a Saved Presentation
Exiting PowerPoint Application

VVVVVVVVVVY




Playing with Multiple Sprites

Introduction to PowerPoint

» More Components of Scratch » Creating a New Presentation Using Blank
» Adding a New Sprite Presentation
» Working with two sprites » Creating a Presentation Using Installed
» Show and Hide a sprite Templates
» Importing Sound from library » Running a Slide Show
» Adding a Backdrop » Applying Themes
SKILLS » Listening, Self direction, Critical thinking, » Listening, Self direction, Critical thinking,

Reasoning, Organizing, Presenting, Self Direction,
Observation and Problem Solving.

Reasoning, Organizing, Presenting, Self
Direction, Observation and Problem Solving.

ACTIVITIES / LAB
WORK

Creating Folders/Files in Windows
Making Charts based on Computer Memory

e Making Presentation in MS-PowerPoint
e Making Presentation by applying Themes
e Making Charts based on Basic terms related to

Internet

ASSESSMENTS

IA-1 (Topics/Chapters)
Ch-1 Computer Hardware and Software
Ch-2 Computer Memory

ORAL TEST(Topic/Chapters)

Ch-1 Computer Hardware and Software

7/

* 1A-2 (Topics/Chapters)
Ch- 7 Introduction to PowerPoint

Ch-6 An Introduction to Internet

«» ORAL TEST(Topic/Chapters)




«» LAB Activities for Assessment
(Topics/Chapters)

Ch-9 Playing with Multiple Sprite (For 1A-1)

Ch-3 Working with Windows (For Half-Yearly)

Ch-6 An Introduction to Internet

«+ LAB Activities for Assessment
(Topics/Chapters)

Ch-7 Introduction to PowerPoint (For 1A-2)

Ch-8 More on PowerPoint (For Annual)

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM (September 2022)

(Topics/Chapters)

1. Computer Hardware and Software
2. Computer Memory
3. Working with Windows

ANNUAL EXAM (March 2023)

(Topics/Chapters)

1. An Introduction to the Internet
2. Introduction to PowerPoint
3. More on PowerPoint
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS -V
April- August October- February
LITERATURE |1. The Toda And The Tahr 1. There’s A Crocodile In Our Pickle Jar
READER 2. The Traders Of Seri 2. The Weather Is Perfect For Running (Poem)

3. Anansi And The Snake
4. Hide And Seek

3. Wrecked On A Desert Island (Assessment)
4. The Newcomer

5. The Plaint Of The Camel (Assessment) 5. The Test

COURSE BOOK > The Crystal Cave > Sir Lawley’s Ghost

> My Early Days With The Chimpanzee > Raoul The Owl

> Colourful Shoes > Grandpa’s Tree

» The Boy Who Saved Holand > My Life

> Jaldi’s Gift > On The Yellow Brick Road
WORKBOOK Worksheet 1-5 Worksheet 6-10
SKILL Listening Skills Listening Skills

Respond to oral messages/ instructions and act accordingly.
Provide opportunities to listen audio-video material to develop
listening and comprehension.

Speaking Skills

Encourage learners to participate in different activities as role
play, enactments, drama and speech.

To use meaningful grammatically correct sentences to narrate
incidents/share experiences.

Reading Skills

To read text with comprehension, locate details and sequence of
events.

Infer the meaning of unfamiliar words from the context while

Respond to oral messages/ instructions and act accordingly.
Provide opportunities to listen audio-video material to develop

listening and comprehension.
Speaking Skills

Encourage learners to participate in different activities as role

play, enactments, drama and speech.

To use meaningful grammatically correct sentences to narrate

incidents/share experiences.
Reading Skills

To read text with comprehension, locate details and sequence

of events.

Infer the meaning of unfamiliar words from the context while




reading a variety of texts.

To connect ideas inferred through reading.

Encourage learners to read independently and silently.
Writing Skills

Encourage learners to use meaningful grammatically correct
sentences to describe and narrate incidents/share personal
experiences.

Attempt to write creatively various types of writings:
Informal letter, Message, Notice, Email writing.

Develop paragraphs with appropriate punctuation marks and
linkers.

reading a variety of texts.

To connect ideas inferred through reading.

Encourage learners to read independently and silently.
Writing Skills

Encourage learners to use meaningful grammatically correct
sentences to describe and narrate incidents/share personal
experiences.

Attempt to write creatively various types of writings:
Informal letter, Message, Notice, Email writing.

Develop paragraphs with appropriate punctuation marks and
linkers.

WRITINGS o Dialogue Writing o Story Writing
e Informal Letter o Description (Person/Place)
e Notice Writing o Message Writing
e Application to The Principal e E Mail Writing
GRAMMAR e Tenses e Tenses
e Modals e Subject-Verb Agreement
e Prepositions e Determiners
«  Conjunction e Prepositions
* Adjectives e Infinitives
ASSESSMENTS |IAl 1A2
v Ppt (May 2022) (Topics/Chapters) v Ppt (November 2022) (Topics/Chapters)
1. Unseen Comprehension 1. Data Interpretation
2. Anansi And The Snake 2. The Weather Is Perfect For Running
3. Dialogue Writing 3. Message Writing
4. Conjunctions 4. Prepositions
v Activities For Assessment (Any Two) v Activities For Assessment (Any Two)
1. Listening 1. Listening
2. Speaking 2. Speaking
3. Activity 3. Activity




SYLLABUS FOR | HALF YEARLY ( September 2022) (Topics/Chapters) ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

EXAMS Reading Reading
Unseen Comprehension/Poem Comprehension/Data Unseen Comprehension/Poem Comprehension/Data
Interpretation Interpretation
Writing Writing
o Dialogue Writing e Story Writing
e Informal Letter o Description (Person/Place)
« Notice Writing e Message Writing
e Application to The Principal e E Mail Writing
Grammar Grammar
e Tenses e Tenses
o Modals e Subject-Verb Agreement
« Prepositions e Determiners
» Conjunction e Prepositions
+ Adjectives e Infinitives
Literature Literature
1. The Toda And The Tahr 1. There’s A Crocadile In Our Pickle Jar
2. The Traders Of Seri 2 The Newcomer
3. Hide And Seek (Poem) 3. The Test

Long questions can be in the form of Diary Entry, Informal

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.

letter, Paragraph or thinking based questions.




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022-23)

SUBJECT - MATHEMATICS

CLASS -V
April- August October-February
CONTENTS 1. Roman Numerals (upto 100) 1. Smart Graphs
2. Large Numbers
3. Operation on large numbers 2. Introduction to Decimals
4. Symmetry, Shapes and Patterns )
3. Introduction to Percentage
(To be assessed through activity) _
4. Perimeter and Area
5. Factors and Multiples
6. HCFand LCM 5. Volume
7. Fractions
8. Geometry (To be assessed through activity) 6. Measurement
SUBTOPICS ROMAN NUMERALS SMART GRAPHS
e Reading and drawing of Pictograph.
o e Reading and Drawing of Bar Graph
* Revising Roman Numerals. e Reading and Drawing of Pie Chart.
e Simple calculations involving Roman Numerals e Tally Marks (arranging data in tabular form).
e Reading of Line Graph

LARGE NUMBERS

Revising 7 and 8 digit numbers

Concept of Indian System of Numeration through
place value chart.

Place value and Face value.

Expanded Notation & Standard Form
Predecessor and Successor

Comparing & ordering large numbers.

INTRODUCTION TO DECIMALS

e Concept of Decimals
Conversion of decimal into Fraction and vice
versa

e Place Value of decimals
Expanded Form & Standard Form




e To build the smallest and greatest 7-8 digit numbers
by repeating and non- repeating digits.
e Concept of International System of Numeration
through place value chart.
e Place value and Face value.
¢ Rounding off numbers.(10,100,1000)
OPERATIONS ON LARGE NUMBERS

e Addition, Subtraction, Multiplication & Division of
Numbers.
BODMAS (Simplification)
Application of Addition, subtraction, multiplication &
division in daily life situations.
¢ Rounding and Estimating Numbers (10,100,100)
SYMMETRY SHAPES AND PATTERNS

e Symmetry
e Patterns
e Solid Shapes
(Excluding: Turns)
MULTIPLES AND FACTORS

Concept of Prime and Composite Numbers

Multiples

Factors

Twin Primes and Co-prime Numbers

Tests of Divisibility(2, 3, 4,5, 6,8, 9, 10,11)
e Concept of prime factorization.

HCE AND LCM

Concept of HCF
Prime Factorisation Method, Long Division Method
Concept of LCM
Prime factorisation method , Long Division Method

Like and Unlike Decimals

Comparing & Ordering of Decimals

Operations on Decimals (+, -, X .%)
e Word Problems.

INTRODUCTION TO PERCENTAGE

e Conversion of fraction as percent and vice
versa.
e Conversion of percent into a decimal and vice
versa.
e Finding the value
e Word Problems
PERIMETER AND AREA

e Perimeter of plane shapes
e Perimeter and Area of rectangle and Square
using formula.
e Application of perimeter and area in daily life
situations.
VOLUME

e To find the volume of cuboid and cube by
counting cubes and by using formula.
(Excluding NETS)

MEASUREMENT

e Bigger and Smaller Units of length , Weight or
Mass and Capacity.

e Conversions .

e Operations on Units of Measurement
(Addition, Subtraction, Multiplication &
Division of Measurement)

e Word Problems

e Estimating Measures




FRACTIONS

Concept of Fraction

Types of Fraction

Finding equivalent fractions.
Reducing a fraction to its lowest term.
Comparing & ordering fractions.
Operations of Fractions(+, -, x, +)
Word Problems

BASICS OF GEOMETRY

Concept of point, line, line Segment and Ray
Angle and its types.

Measuring and of line segment.

Measuring & Drawing angles with protractor.
Types of Lines

Types of Polygon

Types of Triangles

Circle and its parts

Drawing circle of given radius

Relation between radius and diameter.

SKILLS

Number sense related concepts and computation
Arithmetic operations

Visualization

Application and computation

Data Interpretation

Analysis

Computational skills

Application in daily life

Problem solving

Spatial Thinking

Comprehension & computational skills
Analysis

Visualization

Spatial Thinking




ACTIVITIES v" Symmetry: Collage on symmetrical and non symmetrical 1. Addition of Decimal Numbers on Grid.
pictures based on nature, monuments, objects etc. 2. Interpretation of Line Graph .
v Representation of Improper Fraction/ Mixed Fraction on
Number line. (Pg. No. 104)
v" Model :-Angle Maker. ( Pg.No. 164)
ASSESSMENTS 1Al 1A2
s (MAY 2022) (Topics/Chapters) % (NOVEMBER 2022) (Topics/Chapters)
1.Roman Numbers 1. Introduction to Decimals

2.

Large Numbers

% ORAL TEST:-

1. Mental Maths based on Factors and multiples
2. Roman Numerals
3. Tables (2-20)

2. Smart Graphs.
s ORAL TEST:-
1.Area and Perimeter
2. Volume
v" Activities for Assessment

4 Activities for Assessment AL > )

1. Basics of Geometry 1. Addition of Decimal Numbers on Grid.

2. Shapes and Patterns 2. Estimating Measures(P.NO. 231)

3. HHW 3. Model Making of Cube/ Cuboid.
SYLLABUS FOR |HALF YEARLY (SEPTEMBER 2022) (Topics/Chapters) ANNUAL EXAM ( MARCH 2023)
EXAMS 1. Large Numbers (Topics/Chapters)

2. Operation on large numbers 1. Smart Graphs

3. Factors and Multiples 2. Introduction to Decimals

4. HCFand LCM 3. Introduction to Percentage

5. Fractions 4. Perimeter and Area .

5. Volume
6. Measurements




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - SOCIAL SCIENCE

CLASS -V
April-August October-February
Contents | 1. Globes and Maps 1.Natural Resources
2.Locating Places 2.Equatorial climate
3. Weather and Climate 3.Natural Disasters
4.Hot Deserts 4. Freedom struggle before Mahatma Gandhi(1857-

_ 1915)
5.Major Landforms

] . 5.India wins Freedom(1915-1947)
6.Coming to British and the Revolt of

1857 6.Birth Of United Nations

% Annual Project(Sports the integral | 7.Work of UN
part of Life)




Sub Topics

V..V...V

e o o o V

e o o o o \7

Globes and Maps

Definition of a globe

Meaning of Latitudes and
Longitudes

Important parallels of latitudes
Grid-Locating different places
Maps and their usefulness

The language of Maps-colours,
signs and symbols

Locating Places

Latitude

Longitude

Grid

Weather and climate

Factors influencing the climate
Major Climate Zones

Coming to British and the
Revolt of 1857

British rule in our country

The incidents which led to revolt
of 1857

Hot Deserts

Climate

Life in Region

Economic Activities

Modern Life in Hot Desert

Major Landforms
Mountains

Deserts

Plateaus

Deserts

Rivers

V..V...V...V

....V...

.V...

Birth Of United Nations/Work of UN
The main aim and principles of UN
Working of UN

India’s contribution of UN

Natural Disasters

Natural disasters

Causes of natural disasters

How to face natural disasters
Equatorial Climate

Demaographic location

Vegetation and industries

Freedom Struggle before Mahatma
Gandhi(1857-1915)

Social Reformers

Formation of Indian National congress
Policy of Divide and Rule

Towards Independence

India wins Freedom(1915-1947)
Satyagraha

Champaran Campaign

Khilafat Movement

Non Cooperation Movement

Simon Commission

Lahore Congress session,1929

Civil Disobedience Movement
Natural Resources

Classification of Natural Resources
Uses and conservation of Natural Resources




Skills e Thinking and Critical thinking e Thinking and Critical thinking skills
skills e Social Skills
e Social Skills e Emotional Skills
e Emotional Skills e Observation
e Observation e Map Skill
e Map Skill
Activities » Collect photographs, picturesand | Search Work
paste
» Draw diagrams »> Timeline
» Flow chart » Web Diagram
» Timeline » Table making
» Table making > Poster making
» Poster making > Group Presentation
» Group Presentation > Role Play
> Role play » Map Work
» Map Work > Debate
> Poster Making
» Broacher making
Assessment | 1A 1 1A 2

s PPT (May 2022)
1. Globes and Maps

2.Locating Places

« Oral Test
% Frigid Zone
1Activities for Assessments

1.Transport

2.Holidays H.W

<+ PPT(November 2022)
1.Natural Disasters

2. Freedom struggle before Mahatma Gandhi(1857-
1915)

% Oral Test
1.Temperate Grassland

«» Activities for Assessments
Environment and Pollution




Syllabus
for Exams

Half Yearly Exams(September 2022)
1.Locating Places

2. Weather and Climate

3.Hot Deserts

4.Major Landforms

5.Coming to British and the Revolt of
1857

Map Work:
Hot Desert

Diagram: Heat Zones of the Earth

Annual Exams (March 2023)

1.Natural Resources

2.Equatorial climate

3.India wins Freedom(1915-1947)
4.Birth Of United Nations
5.Work of UN

Map Work:

Equatorial climate




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - SCIENCE

CLASS -V

April- August

October- February

CONTENT 1. States ofMatter 1. Skeletal System
2. Soil Erosion and Conservation 2. Air and Water Support Life
3. Growing Plants for Food 3. Force and Energy
4. Safety and First Aid (Holidays Homework/Activity) 4. Natural Disasters
5. Shadows and Eclipses 5. Health and Hygiene
6. Animals around us (Activity) 6. Rocks and Minerals (Activity)
7. Nervous System
8. The Moon (Activity)
SUBTOPICS/ 1. States of Matter 1. Skeletal System
CONCEPTS <+ Atoms and molecules s Skeletal system-its parts and its functions
+» Particles arrangement in three states of matter +» Muscles and its types(excluding limb bones and
¢+ Processes involved in change of state girdles)
+ Different types of changes 2. Air and Water Support L.ife
++ Solubility of substances and properties of + Air and the atmosphere
substances «» Layers of atmosphere
2. Soil Erosion and Conservation ¢+ Composition of air
+»+ Formation of soil +» Properties and uses of air
¢+ Layers of soil s Water
¢+ Composition of soil +¢ Purification of drinking water
¢+ Soil erosion-Causes of soil erosion + Removal of soluble and insoluble impurities from
¢ Soil Conservation water
3. Growing Plants for Food 3. Force and Energy

% Growing plants from seeds,spores,different
parts of the plants
¢+ Seeds dispersal and germination
¢+ Crops and Agriculture
Safety and First Aid (Activity)
% Importance of bicycle, automobile and fire and

X/

% Types of forces
¢+ Simple machine

X/

« Energy-sources of energy ,its types and forms
¢+ Law of conservation of energy

X/

¢+ Transformation of energy from one form to other




water safety
+¢+ First Aid and some important First Aid Tips for
cuts and bruises,Animal bites
Shadows and Eclipses
s+ Types of materials according to path of lights
¢+ Sources: Luminous & non luminous
+« Shadow and its features
¢ Eclipses
+ Reflection of light

L)

. Animals around us (Activity)

% Breathing in animals
¢ Feeding habits in animals
< Movement of animals
Nervous System
¢+ Nervous System-its parts and its functions
+* Brain
++ Spinal cord
¢ Nerves
% Reflex action
%+ Sense organ and its care
The Moon (Activity)
%+ Moon ,its surface and phases
+ Natural and artificial satellites
¢+ Space travel

4. Natural Disasters

+« Earthquake

«» Tsunami

» Volcanoes and its types

% Drought

5. Health and Hygiene

+«+ Food groups

«» Balanced diet

+»+» Diseases

+» Prevention of diseases

6. Rocks and Minerals (Activity)
+ Rocks and its types
+» Minerals- metallic and non-metallic
+« Importance of rocks and minerals

*,

o0

DS

4

L)

L0

0

>

SKILLS e Observational skills e Investigating

e Inferring e Problem solving

e Investigating e Application

e Problem solving e Analysis

e Application e Data interpretation
ACTIVITIES e Lab activity e Model making

e Learning by doing

e Clay model




ASSESSMENTS

Visual aids
Individual activity

PPT (MAY)
States of Matter

Soil Erosion and Conservation

ORAL TEST(MAY)

1.Growing plants for food

4.

Activities for Assessment

1. Safety And First Aid
2.
3. The Moon

Animals Around us

Holidays Homework

e Learning by doing
e Lab visit
1A2
% PPT (NOVEMBER)

1. Skeletal System
2. Air and Water Support Life

% ORAL TEST(OCTOBER)
1. Force and Energy

«+ Activities for Assessment
1. Rocks and Minerals

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM(SEPTEMBER)

SARE A

States of Matter

Soil Erosion and Conservation
Growing Plants for Food
Shadows and Eclipses
Nervous System

ANNUAL EXAM (MARCH)

1. Skeletal System

2. Air and Water Support Life
3. Force and Energy

4. Natural Disasters

5. Health and Hygiene




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)

SUBJECT - ICT
CLASS-V

April —August

October - February

CONTENTS 1. Evolution of Computer 1. Advanced Features of Word
2. Input and Output Devices 2. Introduction to Excel
3. More on Windows 3. Internet and E-Mail
4. Page Formatting in Word

SUBTOPICS Evolution of Computer Advanced Features of Word

» History of Computer

» Calculating Devices

» Generations of Computers

» Types of Computers
Input and Output Devices

> Input Devices
» Output Devices
More on Windows

» Window Media Player

» Control Panel

» Installing and Uninstalling an Application

» Troubleshooting

» Operating Systems for Mobile Devices
Page Formatting in Word

» Page Formatting
» Page Backgrounds

» Find and Replace

> Spelling and Grammar

» Thesaurus

» Drop Cap Effect

> Mail Merge
Introduction to Excel

» Starting MS Excel
» Components of MS Excel 2016 Window
» Entering and Working in a Worksheet
> Types of Data
» Saving a Workbook
> Creating a New Workbook
» Opening a Saved Workbook
» Closing and Exiting MS Excel
Internet and E-Mail

> Internet

» Search Engine
» E-Mail

> Netiquette




> Internet Abbreviations and Emoticons

SKILLS

» Self-direction, Leadership, Critical thinking,
Reasoning, Inquiry, Observation, Prediction,
Problem solving, mental skills, Organizing and
presenting.

» Self-direction, Leadership, Critical thinking,
Reasoning, Inquiry, Observation, Prediction,
Problem solving, mental skills, Organizing and
presenting.

ACTIVITIES / LAB
WORK

e Making MS-Word document on any given topic
using page formatting features.

e Making worksheets using MS-Excel

e Making MS-Word document on topic Internet
and E-Mail and apply Drop Cap, Spelling and
Grammar feature on it.

ASSESSMENTS

» |A-1 (Topics/Chapters)
Ch-2 Input and Output Devices

Ch-1 Evolution of Computers

» ORAL TEST(Topic/Chapters)
Ch-1 Evolution of Computers

» LAB Activities for Assessment
(Topics/Chapters)
Ch-3 More on Windows (For 1A-1)

Ch-4 Page Formatting in Word (For Half-Yearly)

> 1A-2 (Topics/Chapters)
Ch-7 Introduction to Excel

Ch-9 Internet and E-Mail

» ORAL TEST(Topic/Chapters)
Ch-9 Internet and E-Mail

» LAB Activities for Assessment
(Topics/Chapters)
Ch-7 Introduction to Excel (For 1A-2)

Ch-5 Advanced Features of Word




SYLLABUS FOR
EXAMS

HALF YEARLY EXAM ( September 2022)

(Topics/Chapters)

1. Evolution of Computers
2. Input and Output Devices
3. More on Windows

ANNUAL EXAM ( March 2023)

(Topics/Chapters)

1. Advanced Features of Word
2. Introduction to Excel
3. Internet and E-Mail
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - VI

April- August

October- February

LITERATURE
READER

1. Kali And The Rat Snake

2. How The Little Kite Learned To Fly (Poem)
3. Pret In The House

4. Pandora And The Mysterious Box

5. A Day’s Wait (Oral Assessment)

1. The Magical Earth (Assessment)
2. The Cop And The Anthem

3. The Spider And The Fly (Poem)
4. Say The Right Thing

5. The Merchant Of Venice

COURSE BOOK |e Growing Up . Playing Fair
o Nature’s Bounty o The Unexplained
. Furs And Feathers . A Brush With Art
WORK BOOK Worksheets 1-5 Worksheets 6-10
SKILL Listening Skills Listening Skills

The learner responds to different kinds of instructions and directions
in varied context

Providing opportunities in pairs/ groups and encouraged to watch
and listen audio-video material and eminent speakers

Encourage learners to listen to English News and Debates (TV, radio)
as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as Role
Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skills

The learner identifies details, characters, main idea and sequence of
ideas and events in textual/ non-textual material.

Encourage learners to use material from various sources in English to
facilitate comprehension and co relation. Think critically, compares

The learner responds to different kinds of instructions and directions
in varied context

Providing opportunities in pairs/ groups and encouraged to watch and
listen audio-video material and eminent speakers

Encourage learners to listen to English News and Debates (TV, radio)
as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as Role
Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skills

The learner identifies details, characters, main idea and sequence of
ideas and events in textual/ non-textual material.

Encourage learners to use material from various sources in English to
facilitate comprehension and co relation. Think critically, compares




and contrast characters, events, ideas, themes and relates to them.

Writing SKills

Draft, revise and write with appropriate beginning, middle and end,
along with punctuation marks.

Organize sentences coherently with the help of verbal and visual
clues and with a sense of audience.

Know the features of various types of writing Message, E-Mails.,
Notice, Letters

and contrast characters, events, ideas, themes and relates to them.

Writing Skills
Draft, revise and write with appropriate beginning, middle and end,

along with punctuation marks.
Organize sentences coherently with the help of verbal and visual
clues and with a sense of audience.

Know the features of various types of writing Message, E-Mails.,
Notice, Letters

WRITINGS o Notice Writing o Dialogue Writing
o Story Writing o Message Writing
o Dialogue Writing o Descriptive Paragraph
o Letter Of Enquiry o Placing An Order
o Informal Letter o Complaint Letter
GRAMMAR e Tenses o Determiners
e Modals o Tenses
e Conjunctions o Reported Speech
e Prepositions o Relative Clause
e \Dice o Preposition
NOTE- NOTE-
Grammar will be tested in the form of INTEGRATED Grammar will be tested in the form of INTEGRATED
GRAMMAR GRAMMAR
ASSESSMENTS |[l1Al 1A2

v Ppt (May 2022) (Topics/Chapters)
1. Unseen Comprehension
2. Kali And The Rat Snake
3. Notice Writing

4. Conjunctions
1.

2.

3.

Activities For Assessment
Listening

Speaking

Chart On Tenses

v Ppt (November 2022) (Topics/Chapters)
1. Data Interpretation

2. The Cop And The Anthem
3. Message Writing

4, Determiners

Activities For Assessment
1.

2.

3.

Listening
Extempore
Assessment (The Magical Earth)




SYLLABUS FOR

HALF YEARLY ( September 2022) (Topics/Chapters)

EXAMS

Reading
Unseen Comprehension/Poem Comprehension/ Data

Interpretation
Writing
o Notice Writing
o Story Writing
o Dialogue Writing
o Letter Of Enquiry
o Informal Letter
Grammar
e Tenses
Modals
Conjunctions
Prepositions
\oice
NOTE-
Grammar will be tested in the form of INTEGRATED
GRAMMAR

Literature

1. How The Little Kite Learned To Fly (Poem)

2. Pret In The House

3. Pandora And The Mysterious Box

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

Reading
Unseen Comprehension/Poem Comprehension/ Data

Interpretation
Writing
Dialogue Writing
Message Writing
Descriptive Paragraph
Placing An Order
Complaint Letter
rammar
Determiners
Tenses
Reported Speech (Sentence Based)
Relative Clause
Preposition
NOTE-
Grammar will be tested in the form of INTEGRATED
GRAMMAR

.....O.....

Literature

1. The Spider And The Fly (Poem)

2. Say The Right Thing

3. The Merchant Of Venice

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022 - 23)
SUBJECT — MATHEMATICS

CLASS - VI
April- August October-February
CONTENTS 1. Data Handling 1. Decimals
2. Knowing Our Numbers 2. Ratio and Proportion
3. Whole Numbers 3. Understanding Elementary Shapes
4. Symmetry ( to be assessed through activity only) (to be assessed through activity only)
5. Playing with Numbers 4. Mensuration
6. Integers 5. Algebra
7. Fractions 6. Practical Geometry
8. Basic Geometrical Ideas
SUBTOPICS DATA HANDLING DECIMALS
e Collection, organization and interpretation of data in tally e Place value of decimal fractions
bars and table e Decimals on number line
e Pictograph interpretation and construction. Making bar e Comparing decimals
graphs for given data, interpreting bar graphs e Fractions as decimals and vice versa
e Use of decimals in conversions
KNOWING OUR NUMBERS e Addition and subtraction of decimals
e Comparing numbers e Application in daily life
e Number formation RATIO AND PROPORTION
e Use of commas in larger numbers e Concept of Ratio and proportion
e Estimation and rounding off e Word problems on Ratio
e Roman numerals ° Unitary method
WHOLE NUMBERS e Cost Price/ Selling Price/ Profit/loss( worksheet will be
e Properties of whole number given)
* Applications of whole number UNDERSTANDING ELEMENTARY SHAPES
SYMMETRY e Measure of line segments
e Making symmetric figures with one, two or more lines of e Types of angles
symmetry e Problems of clockwise and anticlockwise revolution




PLAYING WITH NUMBERS

e Factors and multiples

Prime, composite, even, odd, co-prime numbers
Prime factorization

Tests of divisibility

HCF, LCM

Word problems of LCM and HCF

INTEGERS

e Meaning of integers

Representation of integers on number line

Ordering of integers

Addition and subtraction of integers on number line
Addition and subtraction of integers

FRACTIONS

e Types of fractions
e Comparing unlike and like fractions
e Addition and subtraction of fractions
Word Problems
BASIC GEOMETRICAL IDEAS

e Concept of point, line, line segment, ray

Parallel lines, perpendicular lines and intersecting lines
Open and closed figures

Angle, Triangle, Quadrilateral and their parts

Circle and its parts

Drawing of circle when radius is given

e Types of triangles and quadrilaterals
e Simple polygons
¢ Identification of faces, edges and vertices of solid shapes

MENSURATION
e Perimeter and area of rectangle and square
e Perimeter of regular shapes
e Application in daily life

ALGEBRA
e Concept of variables
e Expressions with variables
e Using expressions in daily life
e Concept of an equation
e Solving simple equations by transposing
PRACTICAL GEOMETRY
e Introduction to different geometrical tools
e Construction of line segments
e Construction of perpendiculars and perpendicular
bisectors of line segments
e Construction of certain angles with the help of compasses
and protractor
e Construction of angle equal to given angle
e Construction of bisectors of angles
e Drawing concentric circles

SKILLS

Application
Computation skill
Data Interpretation
Number sense
Estimation

Application

Number sense
Problem solving
Spatial Thinking
Computational skills




ACTIVITIES e Lines of symmetry (Pg No. -77 on Lab Manual) e Addition of Decimals( Activity No. 12 on Lab Manual)
e Survey to collect data and representation of this data on e Types of Triangle ( Activity No. 7 on Lab Manual)
Bar Graph. e Design a rectangular park having square and rectangular
e Addition/ Subtraction of integers ( Pg No.- 46, 50) on flower beds and find area of park excluding flower beds.
Lab Manual)
ASSESSMENTS 1Al 1A2
(MAY 2022) (Topics/Chapters) v (NOVEMBER 2022) (Topics/Chapters)
1. Data Handling 1. Ratio and Proportion
2. Knowing Our Numbers 2. Mensuration
% ORAL TEST:- % ORAL TEST:-
Basic Geometrical Ideas, Integers Understanding Elementary Shapes, Mensuration
Activities for Assessment v Activities for Assessment
1. Line of symmetry 1. Addition of Decimal on grid (Pg No. - 59 on Lab
2. Collection and representation of data using Bar Graph Manual)
(survey) 2. Types of Triangles. (Pg No. - 32 on Lab Manual)
3. Addition and subtraction of integers
4. HHW

SYLLABUS FOR

HALF YEARLY (SEPTEMBER 2022) (Topics/Chapters)

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

EXAMS

ouakrwhE

Data Handling

Whole Numbers
Playing with Numbers
Integers

Fractions

Basic Geometrical Ideas

1.

2
3.
4.
5

Decimals

Ratio and Proportion
Mensuration
Algebra

Practical Geometry




CAMBRIDGE INTERNATIONAL SCHOOL
SESSION -2022-23

GRADE -VI

SUBJECT-SOCIAL SCIENCE

April-August October-February
Contents 1.The Solar System and the Earth 1.The Gupta and Post Gupta Period(Political

2.Diversity in India Developments)

3.Hunters and Gatherers(The Earliest People) 2.The Four Realms of the Earth

4.Latitude, Longitude and Time 3.Democratic Government

5.Prejudice, Discrimination and Inequality 4. Panchayati Raj

6.The Vedic Age and Chalcolithic Settlements 5.Urban Self Government

7.Planteray Motions( Rotation and Revolution) 6.Land and sea Topography

8. Government 7.The First Empire(The Mauryans)

8.Early forms of Kingdoms(Janapadas and
+«+ Annual Project(Amazing Universe) Mahajanpadas)
Sub Topics Hunters and Gatherers(The Earliest People) » Democratic Government

Nomads And food gatherers

The three stone ages and importance

The Solar System and the Earth

Solar system and its composition

Celestial bodies, Galaxies and constellations
Diversity in India

Meaning of Prejudices and stereotypes,
Discrimination and equality

Social and economic differences

Evils of casteism and untouchability
Constitutional provisions for equality

The Vedic Age and Chalcolithic Settlements
The Vedas and The Aryans

.‘7..‘7..‘7

.V...

e Meaning and success of Democratic
Government

Equality and justice

» The Gupta and the Post Gupta
Period(Political Development)

The Gupta Dynasty-origin and rule
Achievements of Gupta rulers

Social, political, economic and cultural life
during the period

Urban Self Government

Urban Local self government

Municipal bodies, Functions and welfare
Sources of income

e o o \7




Social and political development of Early and > Early forms of Kingdoms(Janapadas snd
Later Vedic period Mahajanpadas)
» Latitude, Longitude and Time e Janapadas and Mahajanapadas life and society
e Globes and its significance e Case Study-Magadha
e Latitudes and Longitudes » The Four Realms of the Earth
e Local time and International Duration and e Lithosphere
effects e Hydrosphere
e Solstice and Equinox e Atmosphere
» Prejudice, Discrimination and Inequality e Biosphere
e Prejudice and Inequality » Panchayati Raj
e Inequality and Discrimination e Structure of Panchayati Raj
e The Constitution and respect e Rural Adminstration
» Planteray Motions( Rotation and Revolution) » Land and sea Topography
e Rotation e Topography of land
e Circle of illumination e Major Landforms
e Revolution e Topography of the Ocean floor
e Solstice e Topography and Man
e Equinoxes » The First Empire
» Government e The Mauryas —origin and rule
e Need for government e Kalinga war, Dhamma
e Constitution-Foundation of a government e Administration, architecture and decline
¢ Role of government o
e Forms of government
e The Government of India
Skills » Thinking and Critical thinking skills » Thinking and Critical thinking skills
» Social Skills » Social Skills
» Emotional Skills » Emotional Skills
» Observation » Observation
> Map Skill » Map Skill




Activities » Stone Painting Search Work
» Search Work > Timeline
» Timeline » Web Diagram
» Web Diagram » Table making
» Table making > Poster making
» Poster making » Group Presentation
» Group Presentation > Role Play
> Role Play » Map Work
» Map Work » Debate
> Debate > Poster Making
» Broacher making
Assessments | 1Al A2
s PPT (May 2022) < PPT(November 2022)
1.The Solar System and the Earth 1. Democratic Government
2.Diversity in India 2. Early forms of Kingdoms(Janapadas snd
Mahajanpadas)
% Oral Test % Oral Test
1. The First Cities 1.Life in villages and Towns
¢ Activities for Assessments ¢ Activities for Assessments
1.Maps and their essential Features 1. Natural Vegetation And wildlife of India
2.Holidays H.W
Syllabus for | Half Yearly Exams(September 2022) Annual Exams (March 2023)
Exams

1.Hunters and Gatherers(The Earliest People)
2.Latitude, Longitude and Time

3.Prejudice, Discrimination and Inequality
4.The Vedic Age and Chalcolithic Settlements
5. Planetary Motions(Rotation and Revolution)
6.Government

Map Work
1.Hunters and Gatherers(The Earliest People)

Diagram
Phases of Moon

1.The Gupta and Post Gupta Period(Political
Developments)

2.The Four Realms of the Earth

3. Panchayati Raj

4.Urban Self Government

5.Land and sea Topography

6.The First Empire(The Mauryans)

Map Work:
The Gupta and Post Gupta Period(Political

Developments)




2.The First Empire(The Mauryans)

Diagram
Layers of atmosphere

Fold Mountain




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - SCIENCE

CLASS - VI
April- August October- February

CONTENT 1. Components of Food 1. Electricity and circuits

2. Sorting Materials into Groups 2. Getting to Know Plants

3. Food: Where Does it Come From? 3. Body Movements

4. Motion and Measurement of Distances 4. Changes Around Us (Activity)

5. Fun with Magnets 5. Light, Shadows and Reflection

6. Air Around Us (Activity) 6. Separation of Substances

7. Garbage In Garbage Out (Activity) 7. Water (Activity)
SUB 1. Components of Food 1. Electricity and circuits
TOPICS/CONCEPTS <« Major components of food and their functions ¢+ Electric circuit and its components

¢ Types of deficiency diseases % Conductors and insulators

2. Sorting Materials into Groups 2. Getting to Know About Plants

¢ Classification of waste % Classification of plants

+ States and properties of matter ¢ Parts of plants and their functions

>

R/
*

Structure and function of flower, fruit and seed
Body Movements

Body movements in humans and different animals
Skeletal System

. Changes Around Us _(Activity)

3. Food: Where Does it Come From?

%+ Sources of food (plants and animals)

%+ Types of animals on the basis of their nutrition
4.Motion and Measurement of Distances

%+ Modes of transport

*,

¢ W

*

R

X/
o

S

% Measurement of distances and their units % Types of changes
% Types of motion ¢+ Factors affecting changes
5. Fun with Magnets 5.Light, Shadow and Reflection
» Magnetic and non-magnetic materials ¢ Luminous and non-luminous objects

>

7/
*

Classification of objects on the basis of transparency
Shadow and its characteristics
Properties of light

L)

% Properties of magnets
¢ Making of an electromagnet
6.Air Around Us(Activity)

53

A

7/
o




R/
A X4

K/
L4

Air and its components
Air pollution

7._Garbage In Garbage Out(Activity)

R/
L4

K/
A X4

R/
L4

Dealing with Garbage
Plastics- Boon or curse?
\Vermicomposting

6. Separation of Substances

%+ Composition of materials

% Types of mixture and its properties

¢+ Methods of separating constituents of mixtures
7. Water(Activity)

Use of Water

Various ways to get water

Water cycle

Formation of clouds

Rainwater harvesting

K/
A X4

X/ *
L XA X4

X/
X4

L)

e

A

SKILLS +«+ Observation % Inferring

% Inferring % Communicating

< Application ¢ Evaluating

% Problem Solving % Application

% Investigating % Investigating
ACTIVITIES . Classroom Activities . Lab Activities

. Lab Activities o Audio Visual Aids

. Audio Visual Aids o Debate

. Debate o Report Writing

J Learning by Doing o Individual Activity

o Individual Activity o Role Play
ASSESSMENTS 1A1 1A2

» PPT (MAY 2022)
1. Components of Food
2. Sorting Materials into Groups
» ORAL TEST(MAY)
1. Motion and Measurement of Distances

» PPT (NOVEMBER 2022)
1. Electricity and circuits
2. Getting to Know Plants

> ORAL TEST(OCTOBER)
1. Body Movements




> Activities for Assessment > Activities for Assessment

1. Airaround us 1. Water
2. Garbage In Garbage Out 2. Light, Shadow and Reflection
3. Holidays Homework
SYLLABUS FOR HALF YEARLY EXAM ( SEPTEMBER 2022) ANNUAL EXAM ( MARCH 2023)
EXAMS 1. Components of Food 1. Electricity and circuits

2. Sorting Materials into Groups 2. Body Movements

3. Food: Where Does it Come From? 3. Getting to Know Plants

4. Motion and Measurement of Distances 4. Light, Shadows and Reflections
5. Fun with Magnets 5. Separation of Substances




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)

SUBJECT -ICT
CLASS- VI
April —August October— February
CONTENTS 1. Computer Languages 1. HTML5
2. Working in Excel 2. The Internet
3. Formulas and Functions in Excel 3. Cyber Threats and Security
4. Algorithm and Flowchart
SUBTOPICS Computer Languages The Internet
» First Generation Language
» Second Generation Language » Requirements for Internet Connection
» Third Generation Language » Common types of Internet Connections
» Fourth Generation Language > E-mail
» Fifth Generation Language » Managing Contacts in Gmail account
» Translators » Real-Time Communication
Working in Excel HTML5
» Selection in a Worksheet » Defining HTML
» Editing Cell Contents » Features of HTMLS5
» Font Formatting » Tools Required for Creating an HTML
» Number Formatting Document
» Inserting Cells, Rows and Columns » HTML tags, Elements and Attributes
» Deleting Cells, Rows and Columns » HTML document structure
» Resizing Rows and Columns » Heading, Paragraph and Line break elements
» Copying and Moving Data

» Auto Fill Feature
Formulas and Functions in Excel
> Formulas

Cyber Threats and Security

>

Malware and its Types




» Using Formulas » Cyber Security
» Types of Cell Reference Algorithm and Flowchart
» Copying Formula of Another Worksheet > Algorithm
» Functions > Flowchart
» AutoSum Feature
» Function Library
» Formula Errors
SKILLS » Self-direction, Leadership, Critical thinking, » Self-direction, Leadership, Critical thinking,
Reasoning, Inquiry, Observation, Prediction, Reasoning, Inquiry, Observation, Prediction,
Problem solving, mental skills, Organizing and Problem solving, mental skills, Organizing and
presenting. presenting.
ACTIVITIES/ e Create a worksheet in Excel on the basis of given e Making Web Pages
LAB WORK data in the lab.
ASSESSMENTS % 1A-1 (Topics/Chapters) % 1A-2 Topics/Chapters)

Ch-1 Computer Languages
Ch-2 Working in Excel

ORAL TEST((Topic/Chapters)
Ch-1 Computer Languages

LAB Activities for Assessment
(Topics/Chapters)

Ch-2 Working in Excel

Ch-3 Formulas and Functions in Excel

Ch-7 HTML5
Ch-8 The Internet

% ORAL TEST(Topic/Chapters)
Ch-8 The Internet

«» LAB Activities for Assessment
Ch-9 Cyber Threats and Security

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM ( September 2022)

(Topics/Chapters)

1. Computer Languages
2. Working in Excel

3.

Formulas and Functions in Excel

ANNUAL EXAM ( March 2023)

(Topics/Chapters)

1. HTML5

2. The Internet

3. Cyber Threats and Security
4. Algorithm and Flowchart
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - ViI
April- August October- February

LITERATURE 1. When Wishes Come True 1. The Night We Won the Buick
READER 2. Mother to Son (Oral Assessment) 2. Two’s Company (Assessment)

3. The Happy Prince 3. Experiments

4. All about a Dog 4. Packing

5. In the Bazaars of Hyderabad 5. Daffodils
COURSE BOOK |e School Years o Nature-Creator and Destroyer

o Wanderlust o Life’s Simple Comedies

o Real Life Heroes o The Unknown
WORKBOOK Worksheets 1-5 Worksheets 6-10
SKILL Listening Skills Listening Skills

The learner responds to different kinds of instructions and
directions in varied context

Providing opportunities in pairs/ groups and encouraged to
watch and listen audio-video material and eminent speakers
Encourage learners to listen to English News and Debates (TV,
radio) as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as
Role Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skill

The learner identifies details, characters, main idea and
sequence of ideas and events in textual/ non-textual material.

The learner responds to different kinds of instructions and
directions in varied context

Providing opportunities in pairs/ groups and encouraged to
watch and listen audio-video material and eminent speakers
Encourage learners to listen to English News and Debates (TV,
radio) as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as
Role Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skill

The learner identifies details, characters, main idea and
sequence of ideas and events in textual/ non-textual material.




Encourage learners to use material from various sources in
English to facilitate comprehension and co relation. Think
critically, compares and contrast characters, events, ideas,
themes and relates to them.

Writing Skills

Draft, revise and write with appropriate beginning, middle and
end, along with punctuation marks.

Organize sentences coherently with the help of verbal and
visual clues and with a sense of audience.

Know the features of various types of writing Message, E-
Mails., Notice, Letters.

Encourage learners to use material from various sources in
English to facilitate comprehension and co relation. Think
critically, compares and contrast characters, events, ideas,
themes and relates to them.

Writing Skills

Draft, revise and write with appropriate beginning, middle and
end, along with punctuation marks.

Organize sentences coherently with the help of verbal and
visual clues and with a sense of audience.

Know the features of various types of writing Message, E-
Mails., Notice, Letters.

WRITINGS e Message Writing o Notice Writing
e Dialogue Writing J Letter of Enquiry
e Enquiry Letter o Letter of Placing an order
o Complaint Letter o Dialogue Writing
e Story Writing o Complaint Letter
GRAMMAR o Tenses o Modals
o Relative Clause o Prepositions
o Subject verb Agreement o Noun Clause
o Determiners o Reported Speech
o Conjunctions o Tenses
NOTE- NOTE-
Grammar will be tested in the form of INTEGRATED Grammar will be tested in the form of INTEGRATED
GRAMMAR GRAMMAR
ASSESSMENTS

PPT (MAY 2022) (Topics/Chapters)

Unseen Comprehension
When Wishes Come True
Message Writing
Conjunctions (Integrated)
Activities for Assessment

\%WNP\E

PPT (NOVEMBER 2022) (Topics/Chapters)

Data Interpretation

Packing

Notice Writing

Relative Clause (Integrated)
Activities for Assessment

\%WNP\E




1. Listening 1. Listening

2. Speaking 2. Speaking

3. Activity 3. Activity
SYLLABUS FOR |HALFYEARLY ( September 2022) (Topics/Chapters) ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)
EXAMS

Reading Reading

Unseen Comprehension/ Poem Comprehension/Data
Interpretation
Writing
e Message Writing
Dialogue Writing
Enquiry Letter
Complaint Letter
Story Writing

Grammar

° Tenses

. Relative Clause

o Subject verb Agreement
. Determiners

o Conjunctions

NOTE-
Grammar will be tested in the form of INTEGRATED

GRAMMAR

Literature

1. All about a dog

2. In the Bazaars of Hyderabad

3. The Happy Prince

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.

Unseen Comprehension/Poem Comprehension/Data
Interpretation

Writing

Notice Writing

Letter of Enquiry

Letter of Placing an order

Dialogue Writing

Complaint Letter

Grammar
. Modals
Prepositions
Noun Clause
Reported Speech
Tenses
NOTE-
Grammar will be tested in the form of INTEGRATED
GRAMMAR

Literature

1 The Night We Won the Buick

2. Experiments

3. Daffodils

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-23)
SUBJECT — MATHEMATICS

CLASS - VI
April- August October-February

CONTENTS 1. Triangles and its properties

1. Data Handling 2. Perimeter and Area

2. Integers 3. Congruence of triangles

3. Linesand Angles 4. Comparing quantities

4. Rational numbers 5. Practical geometry

5. Simple Equations 6. Exponents and powers

6. Algebraic Expressions

7. Symmetry ( To be assessed through activity )
SUBTOPICS DATAHANDLING TRIANGLE AND ITS PROPERTIES

e Measures of Central Tendency (mean, median and mode)
¢ Interpretation and drawing of single and double bar graph
e Chance and Probability

INTEGERS

e Recall of Integer and number line
e Multiplication and division of integers
e Properties of Integers and word
problems including integers (all operations)

LINES AND ANGLES

e Pairs of angles (linear, supplementary, complementary,
adjacent, vertically opposite)

e Properties of parallel lines with transversal (alternate,
corresponding, interior, exterior angles)

e Types oftriangles

e Angle sum property

e Exterior angle property

e Pythagoras property and related situations

PERIMETER AND AREA
e Revision of Perimeter and area of rectangle and square

and their application in daily life

e Area oftriangle

e Area of parallelogram

e Perimeter and area of circle, area between two rectangles
and two concentric circles

CONGRUENCE OF TRIANGLES

e Congruence through superimposition and its extension to

simple geometrical shapes e.g. circle, triangle




RATIONAL NUMBERS
e Introduction of rational numbers
e Comparison of rational numbers
e Rational number between two rational numbers
e Word problems on rational numbers
SIMPLE EQUATIONS
e Simple equations using one variable (in contextual
problems) with two operations
ALGEBRAIC EXPRESSIONS
e Generate expressions (simple) involving one or two
variables, identifying constants, powers, like and unlike
terms, degree of expressions and simplification (addition
& subtraction) of algebraic expression
SYMMETRY
e Concept of Symmetry
e Lines of Symmetry for Regular Polygons
e Rotational Symmetry

e Basic rules of congruency by verification (SSS, SAS,
ASA, RHS)

COMPARING QUANTITIES
e Ratio and proportion

e Unitary method
e Percentage and its application to Profit and loss
e Simple interest

PRACTICAL GEOMETRY

e Construction of a line parallel to a given line from a point
outside it
e Construction of triangles based on congruency rules

EXPONENT AND POWERS

e Laws of Exponents
Expressing large numbers in the standard form

SKILLS e Application e Application in daily life
e Data Interpretation and analysis e Problem solving
e Number sense and computational skills e Spatial Thinking
e Visualization e Computational skills
e Spatial Thinking e Logical reasoning
e Problemsolving
e Logical reasoning
ACTIVITIES e Complementary/ Supplementary Angles e Angle sum property(Activity No.11,Pg. no. 40)

(Activity No.3, pg no. 13)
e Line of symmetry (Activity No. 21, Pg. No. 75)

e Area of Circle (Activity No.19, Pg. N0.69)




e Bar Graph (Activity No. 2, Pg. No. 10)

ASSESSMENTS

1AL
o (MAY 2022) (Topi hapter
1. Data Handling
2. Integers

% ORAL TEST:-
Lines and angles
Algebraic Expressions
v Activities for Assessment
1. Symmetry
2. HHW

1A2
v (NOVEMBER 2022) (Topics/Chapters)
1. Triangles and its properties
2. Perimeter and Area
< ORALTEST:-
Perimeter and area
Triangles and its properties
v Activities for Assessment
1. Angle sum property of triangle

SYLILABUS FOR
EXAMS

HALFYEARLY (SEPTEMBER 2022) (Topics/Chapters)

Data Handling

Lines and Angles
Rational numbers
Simple Equations
Algebraic Expressions

abkwbdE

ANNUAL EXAM (MARCH 2023) (Topics/Chapters)

1. Triangles and its properties
2. Comparing quantities

3. Practical geometry

4. Congruence of triangles

5. Exponents and powers




CAMBRIDGE INTERNATIONAL SCHOOL
SESSION -2022-23
GRADE -VII
SUBJECT-SOCIAL SCIENCE

April-August October-February

Contents 1. Tracing Changes Through a thousand years. 1. Towns, traders and craftpersons
2. New kings and kingdoms 2. Tribes, nomads and settled communities
3. The Delhi Sultans 3. 18" Century political formations
4.Role of Government in Health 4, Women Change the World
5. How the state Government works 5. Markets around us
6. Environment 6. Natural VVegetation and Wildlife
7. Air 7. Life inthe Temperate Grasslands
8. Water 8. Human Environment Interactions

¢+ Annual Project(Sufism)
Sub Topics » Tracing Changes through a thousand » Towns, traders and craftpersons

years.
New and old terminologies
Historians and their sources

New social and political groups
Region and Empire

Old and New Religions

Thinking about Time and Historical
Periods

New kings and kingdoms

The emergence of new Dynasties
Administration in the Kingdoms
Warfare for Wealth

Acloser Look: The Cholas

The Delhi Sultans

Finding out about the Delhi Sultans

.V....V

Administrative Centres

Temple Towns and Pilgrimage Centres

A Network of Small Towns

Traders Big and Small

Crafts in towns

Acloser Look: Hampi, Masulipatnam and Surat
Tribes, nomads and settled communities
Beyond Big cities: Tribal Societies

Who were Tribal People?

How Nomads and Mobile People Lived
Acloser Look: The Gonds and Ahoms

18™ Century political formations

e The Crisis of the Empire and the later mughals
e Emergence of new states

e The old mughal provinces

....V......




°*vVv

..V...V..V..V...V....V....

From garrison Town to Empire
Administration and Consolidation under
the Khaljis and Tughlugs

On Equality

Equal right to vote

Other kinds of equality

Recognising dignity

Equality in Indian democracy

Issues of equality in other democracies
Role of Government in Health
What is health

Healthcare in India

Public and Private health care services
What can be done?

How the state Government works
Who is an MLA?

Adebate in the Legislative assembly
Working of the Government
Environment

Natural Environment

Human Environment

Air

Composition of the Atmosphere
Weather and climate

Water

Distribution of water bodies

Ocean Circulations

Ocean Currents

Inside our Earth

Interior of the Earth

Rocks and minerals

.V..V......V....V..

.V.

The watan jagirs of the Rajputs
Seizing independence

Women Change the World

Fewer opportunities and rigid expectations
Learning for change

Schooling and education today
Women’s movement

Markets around us

Weekly market

Shops in the neighbourhood
Shopping complexes and malls
Chain of markets

Markets everywhere

Markets and equality

Natural Vegetation and Wildlife
Forests

Grasslands

Life in the Temperate Grasslands
The Prairies

The Velds

Human Environment Interactions
Life in the Amazon Basin

Life in the Ganga-Brahmaputra Basin




Skills » Thinking and Critical thinking skills » Thinking and Critical thinking skills
» Social Skills » Social Skills
» Emotional Skills » Emotional Skills
» Observation » Observation
» Map Skill » Map Skill
Activities » Search Work » Search Work
» Timeline » Timeline
» Web Diagram » Web Diagram
» Table making » Table making
» Poster making » Poster making
» Group Presentation » Group Presentation
» Role Play » Role Play
» Map Work » Map Work
» Debate » Debate
» Poster Making
» Broacher making
Assessments | 1AL 1A 2
< PPT (May 2022) s PPT(November 2022)
1. Tracing Changes Through a thousand years. 1.Towns, traders and craft persons
2. Environment 2.Human Environment Interactions
% Oral Test % Oral Test
1. Growing up as Boys and Girls 1. Devotional Path to Divine
2. The Mughal Empire 2. Understanding Media
3. On Equality Activities for Assessments
+ Activities for Assessments 1. Human environment settlements, transport and
1. Our Changing Earth communication
2. Rulers and Builders 2. The making of regional cultures
3. Inside our earth
Syllabus for Half Yearly Exams(September 2022) Annual Exams (March 2023)
Exams 1. New kings and kingdoms 1. Tribes, nomads and settled communities

2. The Delhi Sultans

2.18" Century political formations




3. Role of Government in Health 3. Women Change the World

4. How the state Government works 4. Markets around us

5. Air 5. Natural Vegetation and Wildlife

6. Water 6. Life inthe Temperate Grasslands

Map Work

History : The Kingdoms — Palas, Pratiharas, Map Work:

Rashtrakutas and Cholas History: Tribal communities — Ahoms, Gonds, Mundas,

Geography: Diagram of Water Cycle and Types | Kolis, Berads and Khokhars

of Rainfall with explanation. Geography: Grasslands- Savanna, Campos, Lianos,
Pampas, Down, Velds and Prairie
Deserts- Sahara and Ladakh




CAMBRIDGE INTERNATIONAL SCHOOL

SYLLABUS (2022-2023)
SUBJECT-SCIENCE
CLASS-VII

April-August

October- February

CONTENTS

. Nutrition in Plants

. Motionand Time

. Heat

. Nutrition in Animals

. Physical and Chemical Changes
. Acids, Bases and Salts

. Respiration in Organisms

. Forests: Our lifeline (Activity)

A WDNERE

0o ~N o Ol

1. Fibre to Fabric (Activity)

2. Transportation in Animals and Plants
3. Reproduction in Plants

4. Electric Current and its Effects

5. Light

6. Soil

7. Water: A precious Resource

8. Wastewater Story

SUBTOPICS/CONCEPTS

[y

. Nutrition in Plants
¢+ Nutrition and different modes of Plant nutrition
¢+ Heterotrophic plants and their nutrition
. Motion and Time
+»» Time and its measurement
¢+ Periodic motion of pendulum
%+ Speed, its types and their graphical representation
t
+» Measures and modes of transfer of heat
++ Conductors and insulators
4. Nutrition in Animals
+«» Different animal nutrition with holozoic nutrition
¢+ Nutrition in human beings and ruminants
+ Different types of teeth

5. The Living Worlds and its Surroundings
% Factors affecting weather and climate

N

w
L
)
QO

1. Eibres to Fabric

+«+ Animal fibres- Wool and Silk

+«+ Their extraction techniques

¢+ Health hazards
2. Transportation in Animals and Plants

¢+ Transport of substance in plants and

animals

+«+ Human circulatory system

¢+ Excretion in human, plants and animals
3.Reproduction in Plants

+«+ Reproduction- Asexual and Sexual

+«+ Explanation of modes of reproduction
4. Electric Current and its Effects

«¢+ Electric circuits and components

+ Effects of electric current

¢ Electromagnets




o

% Adaptations of animals in different climates

R/

% Soil and its characteristics

X/

6. Physical and Chemical changes
+¢ Chemical formulae and types of reactions

+ Separation technique
Z. Acids, Bases and Salts
¢+ Acids and bases- types, properties and uses
+* Indicators and salts
8. Respiration in organisms
+» Respiration and its Types
+¢+ Respiration in plants, animals and human beings
9. Eorests: Our Lifeline
+¢+ Importance of forests
+¢* Need of their conservation

®,

% Light, its characteristics and related
phenomenon
% Mirrors and lenses- types,
characteristics and uses
6. Water: A Precious Resource
% Water- importance, types, uses and
distribution
¢+ Scarcity of water- causes and effects
% Conservation of water
L Sail
¢+ Soil Profile
«» Soil Types, Properties of Soil
+* Moisture in Soil
¢+ Absorption of water by Soil.
8. Wastewater Story
% Sources, treatment and control of

X/

=

waste
%+ Effects of improper waste management
SKILLS +¢ Observation % Inferring
+¢ Inferring % Communicating
«¢ Application % Evaluating
+¢ synthesizing % Application

53

AS

Investigating
Synthesizing

X/
X4

L)




ACTIVITIES » Classroom activities » Lab activities
» Lab activities » Audio visual aids
» Slide observations » Debate
» Model making » Report writing
» Audio visual aids » Model making
» Debate > Roleplay
» Field visit
ASSESSMENTS 1AL 1A2

<+ PPT (MAY 2022)
1. Nutrition in plants
2. Time and motion

<+ ORAL TEST (MAY)
1.Heat

% Activities for Assessment
1. Forest Our Lifeline
2. Holiday homework

o |

o

PPT (NOVEMBER 2022)

1. Reproduction in plants
2. Transportation in plants and
animals

< ORAL TEST (OCTOBER)
1. Fibresto Fabric

« Activities for Assessment
1. Fibre to Fabric
2. Light

SYLLABUS FOR EXAMS

HALFYEARLY EXAM (SEPTEMBER 2022)

Heat

Nutrition in Plants

Nutrition in Animals

Motion and Time

Physical and Chemical Changes
Acids, Bases and Salts
Respiration in Organisms

NoohkowhE

ANNUAL EXAM (MARCH 2023)

Reproduction in Plants
Transportation in Animals and Plants
Electric Current and its Effects

Light

Soil

Wastewater Story

Water: A precious Resource

NogakrwdpE




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)

SUBJECT - ICT
CLASS- VII
April -August October- February

CONTENTS 1. Number System 1. Listsand Tables inHTML5

2. Excel as a Database 2. Introduction to Python

3. Chartsin MS Excel 3. Working with Python

4. More on HTML5 4. Internet Services
SUBTOPICS Number System Lists and Tablesin HTMLS

Decimal Number System
Binary Numbers System

Octal Number System
Hexadecimal Number System
Conversions in Number Systems
Computer Arithmetic

VVVVVY

Excel as a Database

Using a Form to Enter Data
Searching a Record
Deleting a Record

Sorting and Filtering Data
Data Validation

VVVYYVY

Charts in Excel

Components of Chart
Commonly Used Charts
Creating a Chart

Working with Chart Elements
Combo Charts and Sparklines
Consolidating Data

VVVYVVY

» Properties of Lists
» Nested and Description List

ion to Python
Introduction to Programming
Interpreter and Compiler
Modes of Python
Keywords and variables in Python
Data types
The Assignment Operator
Using Print () Function

-]
i+
m]

VV VYV VYVYY

Working with Python
» The Input () Function

» Operator and its Types
» Operator Precedence
» BODMAS and PEDMAS

Internet Services
» Social Networking
» Blogs




More on HTML5

Different Methods of Applying CSS
Inline Styles

Background Properties

Text Properties

YVVVVVYYVY

» E-Commerce

Ethics and safety Measures

Font Properties » Computer Ethics
Margin Properties » Unethical Computer Practices
Border Properties » Cyber Against Individual/Society
» Safety Measures
» Digital Footprints
SKILLS » Listening, Critical thinking, Reasoning, » Listening, Critical thinking, Reasoning,
Organizing, Presenting, Self Direction, Observation Organizing, Presenting, Self Direction,
and Problem Solving Observation and Problem Solving
ACTIVITIES/ » Chart designing in MS Excel » Activity based on HTML and Python
LAB WORK Programming
ASSESSMENTS

» 1A-1 (Topics/Chapters)
Ch-2 Excel as a Database
Ch-3 Charts in MS Excel

«» ORAL TEST(Topic/Chapters)
Ch-2 Excel as a Database

<+ LABACtivities for Assessment
(Topics/Chapters)
Ch-2 Excel as a Database
Ch-3 Charts in MS Excel
Ch-5 More on HTML5

s 1A-2 (Topics/Chapters)
Ch-7 Introduction to Python
Ch-9 Internet Services

s ORAL TEST(Topic/Chapters)
Ch-9 Internet Services

«» LABACctivities for Assessment
(Topics/Chapters)
Ch-4 More on HTML5
Working with Python




SYLLABUSFOR | HALEFYEARLY EXAM ( September 2022 ANNUAL EXAM (March 2023)

EXAMS (Topics/Chapters) (Topics/Chapters)
1. Number System 1. Listsand Tables inHTML5
2. Excel as a Database 2. Introduction to Python
3. Chartsin MS Excel 3. Internet Services
4. More on HTML5 4. Ethics and safety Measures
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CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - ENGLISH

CLASS - VIII

April- August

October- February

LITERATURE
READER

1. Boyhood Day’s

2. Father’s Help

3. Jamaican Fragment

4. The Secret of the Machines

5. A Newspaper is a Collection of Half-Injustices (Oral
Assessment)

1. The Nightingale and the Glow-worm
2. Her First Party

3. The Stalled Ox

4. On A Night of Snow (Assessment)

5. The Unexpected

COURSE BOOK  |e Human Bonds o Unlikely Destinations
o Nurturing Nature o Man And Machine
o Conflict and Hope o Beyond the \eil
WORKBOOK Worksheets 1-5 Worksheets 6-10
SKILL Listening Skills Listening Skills

The learner responds to different kinds of instructions and
directions in varied context

Providing opportunities in pairs/ groups and encouraged to
watch and listen audio-video material and eminent speakers
Encourage learners to listen to English News and Debates (TV.,
radio) as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as
Role Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skills

The learner identifies details, characters, main idea and

The learner responds to different kinds of instructions and
directions in varied context

Providing opportunities in pairs/ groups and encouraged to
watch and listen audio-video material and eminent speakers
Encourage learners to listen to English News and Debates (TV.,
radio) as input for discussions and debating skills.

Speaking Skills

Encourage students to participate in different activities such as
Role Play, skit, Drama and Speech.

Encourage learners to share their experiences in pair/ gropus.
Reading Skills

The learner identifies details, characters, main idea and




sequence of ideas and events in textual/ non-textual material.
Encourage learners to use material from various sources in
English to facilitate comprehension and co relation. Think
critically, compares and contrast characters, events, ideas,
themes and relates to them.

Writing Skills

Draft, revise and write with appropriate beginning, middle and
end, along with punctuation marks.

Organize sentences coherently with the help of verbal and
visual clues and with a sense of audience.

Know the features of various types of writing Message, E-
Mails., Notice, Letters

sequence of ideas and events in textual/ non-textual material.
Encourage learners to use material from various sources in
English to facilitate comprehension and co relation. Think
critically, compares and contrast characters, events, ideas,
themes and relates to them.

Writing Skills
Draft, revise and write with appropriate beginning, middle and

end, along with punctuation marks.
Organize sentences coherently with the help of verbal and
visual clues and with a sense of audience.

Know the features of various types of writing Message, E-
Mails., Notice, Letters

WRITINGS

o Letter of Placing an Order o Description (person, place, thing)

o Notice Writing o Message Writing

o Complaint Letter o Letter to The Editor

o Story Writing o Enquiry Letter

o Descriptive Paragraph o Story Writing
GRAMMAR o Tenses o Determiners

o Modals o Tenses

o Relative Clause o Prepositions

o Conjunctions o Noun Clause

o Reported Speech o Reported Speech

NOTE- NOTE-

Grammar will be tested in the form of INTEGRATED
GRAMMAR

Grammar will be tested in the form of INTEGRATED
GRAMMAR




ASSESSMENTS

1Al

v PPT (MAY 2022) (Topics/Chapters)
1. Unseen Comprehension
2. Boyhood Day’s

3. Notice Writing

4. Relative Clause
1.

2.

3.

Activities for Assessment
Listening
Speaking
Activity

2

v PPT (NOVEMBER 2022) (Topics/Chapters)
1 Data Interpretation

2 The Stalled Ox

3 Message Writing

4 Determiners (Editing, gap filling)
Activities for Assessment
1

2

3

Listening
Speaking
Activity

SYLLABUS FOR

HALF YEARLY ( September 2022) (Topics/Chapters)

EXAMS

Reading
Unseen Comprehension/Poem Comprehension/Data

Interpretation
Writing

o Letter of Placing an Order
o Notice Writing
o Complaint Letter
o Story Writing
o Descriptive Paragraph
Grammar
o Tenses
o Modals
o Relative Clause
o Conjunctions
o Reported Speech
NOTE-
Grammar will be tested in the form of INTEGRATED
GRAMMAR
Literature

1. The Secret of the Machines

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

Reading
Unseen Comprehension/Poem Comprehension/Data

Interpretation
Writing

o Description (person, place, thing)
o Message Writing
o Letter to The Editor
o Enquiry Letter
o Story Writing
Grammar
o Determiners
o Tenses
o Prepositions
o Noun Clause
o Reported Speech
NOTE-
Grammar will be tested in the form of INTEGRATED
GRAMMAR
Literature

1. The Unexpected




2. Father’s Help

3. Jamaican Fragment

Long questions can be in the form of Diary Entry, Informal
letter, Paragraph or thinking based questions.

2. The Nightingale and the Glow-worm

3. Her First Party

Long questions can be in the form of Diary Entry,
Informal letter, Paragraph or thinking based questions.




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-23)
SUBJECT — MATHEMATICS

CLASS - VIII
April- August October-February

CONTENTS 1. Rational numbers 1. Introduction to graphs

2. Data Handling 2. Understanding quadrilaterals

3. Square and square roots 3. Comparing quantities

4. Cube and cube roots 4. Mensuration

5. Algebraic expression and Identities 5. Linear equation in one variable

6. Factorization 6. Practical geometry

7. Exponents and powers
SUBTOPICS RATIONAL NUMBERS INTRODUCTION TO GRAPHS

e Properties of rational numbers

e Distributive properties

o Representation of Rational numbers on a number line
DATA HANDLING

e Interpretation of data
e Express in the graphical form using histograms
e Piechart
e Probability
SQUARE AND SQUARE ROOTS

e Basic knowledge of squares

e Perfect squares

e Finding squares by different methods
CUBE AND CUBE ROOTS

e Basic knowledge of cubes
e Cube root by prime factorization

e Line graph
e Time & distance graph, temperature time graph
e Applications

UNDERSTANDING QUADRILATERALS

e Angle sum property of quadrilateral,
e Types of quadrilateral & their properties
COMPARING QUANTITIES

e Profit
e Loss
e Discount

e Compound interest
MENSURATION

e Area of quadrilateral

e Area of trapezium

e Area of rhombus

e Area of polygons by dividing it into shapes




ALGEBRAIC EXPRESSION AND IDENTITIES
e Addition & subtraction of algebraic expressions
e Multiplication of polynomials
e Standard identities & their applications
FACTORIZATION
e Factorization of polynomials using different methods i.e
e Common Factor
e By identities
¢ Division of Algebraic expressions
EXPONENTS AND POWERS
e Laws of Exponents
e By using laws express the numbers in the standard form

e Surface Area of cube , cuboid , cylinder
e \olume of cube , cuboid , cylinder

LINEAR EQUATION IN ONE VARIABLE

Solving linear equations

Applications

Relation between age, area, number, ratio, combination
of currency notes etc

PRACTICAL GEOMETRY

Construction of different types of quadrilateral

SKILLS

e Application and computation o Application in daily life
e Data Interpretation e Problem solving
e Analysis e Spatial Thinking
e Number sense e Comprehension &computational skills
e Computational skills e Analysis
e Visualization
e Spatial Thinking
e Problem solving
ACTIVITIES e Statistics (Activity No. 9/Pg. No. 35 on Lab Manual) e Sum of interior angles of a quadrilateral is 360°by

e Proof of identities(a + b)? = a® + b% + 2ab,
(Activity No. 10a/Pg.No. 40 on lab Manual)

cutting& pasting method

(Activity No.2/ Pg, No. 10 on Lab Manual)

To find the curved & total surface area of cylinder by
paper cutting & folding(Activity No.15/ Pg. No.63 on
Lab Manual)




ASSESSMENTS

< (MAY 2022) (Topics/Chapters)

1. Rational Numbers

2. Data Handling

s ORALTEST:-
1. Algebraic expression and Identities
2. Exponents and Powers

v Activities for Assessment
1. Pie Chart
2. HHW

1A2

1.
2.

X/
°

4
1.
2.

(NOVEMBER 2022) (Topics/Chapters)

Introduction to graphs
Understanding Quadrilaterals
ORAL TEST:-

Mensuration

Understanding Quadrilaterals
Activities for Assessment
Quadrilateral

Mensuration

SYLLABUS FOR

HALF YEARLY ( SEPTEMBER 2022) (Topics/Chapters)

EXAMS

Data Handling

Square and Square roots

Cube and Cube roots

Algebraic expression and Identities
Factorisation

Exponents and Powers

Sk~ wdE

ANNUAL EXAM ( MARCH 2023) (Topics/Chapters)

1.

2
3.
4.
5

Introduction to graphs

. Comparing quantities

Mensuration
Linear equation in one variable
Practical geometry




CAMBRIDGE INTERNATIONAL SCHOOL
SESSION -2022-23
GRADE -VI1lII
SUBJECT-SOCIAL SCIENCE

April-August October-February
Contents 1. From trade to territory 1. The making of the national movement 1870S — 1947
2. Ruling the countryside 2. India after independence
3. When people rebel 1857 and after 3. Civilizing the native educating the nation
4. Resources 4. Mineral and power resources
5. Land, soils, water, natural vegetation 5. Agriculture
and wildlife resources 6. Human resources
6. Industries 7. The judiciary
7. Why do we need parliament 8. Understanding of our criminal justice system
8. Understanding laws
% Annual Project( Caves of India)
Sub Topics » From trade to territory » The making of the national movement 1870S —
e East India company comes east 1947
e Company rule expands e The emergence of nationalism
e Setting up a new administration e The growth of mass nationalism
» Ruling the countryside e March to Dandi
e The company becomes the diwan e Quit India and later
e Crops for Europe » India after independence
e The blue rebellion and after e Anew and divided nation
» When people rebel 1857 and after e Constitution is written
e Policies and the people e How were states to be formed
e A mutiny becomes a popular rebellion ¢ Planning for development
e The company fights back e The nation 60 years old
» Resources
e Types of resources » Civilizing the native educating the nation




.V..V.....V

...V...

Conserving resources

Land, soils, water, natural vegetation
and wildlife resources

Land and conservation of land resources
Soil and factors of soil formation
Degradation of soil and conservation
measures

Water and problems of water availability
Conservation of water resources
Natural vegetation and white light
Distribution and conservation of natural
vegetation and wildlife

Industries

Classification of industries

Factors affecting location of industries
Industrial system

Industrial regions

Distribution of major industries

The Indian constitution

Why does a country need a Constitution
The Indian Constitution- Key features
Why do we need parliament

Why should people decide?

People and their representatives

The role of the Parliament

Who are the people in Parliament
Understanding laws

Do Laws apply to all?

How do new Laws come about?
Unpopular and Controversial Laws

....V...

...V....V...V....V..V

How the British saw education
What happened to the local schools
The agenda for a national education
Mineral and power resources
Types of minerals

Distribution of minerals

Uses and conservation of minerals power resources

Conventional and Non-conventional source of
energy

Agriculture

Types of farming

Agricultural development

Human resources

Distribution of population

Factors affecting distribution of population
Population change

Population composition

The judiciary

What is the role of the Judiciary
Independent Judiciary

Structure of courts in India
Understanding of our criminal justice system
Role of police

Role of public prosecutor

Role of judge

Fair trial

Law and social justice

Bhopal gas tragedy

Worker’s worth

Enforcement of safety laws




Skills » Thinking and Critical thinking skills » Thinking and Critical thinking skills
» Social Skills » Social Skills
» Emotional Skills » Emotional Skills
» Observation » Observation
» Map Skill » Map Skill
Activities » Search Work » Search Work
» Timeline » Timeline
» Web Diagram » Web Diagram
» Table making » Table making
» Poster making » Poster making
» Group Presentation » Group Presentation
> Role Play > Role Play
» Map Work » Map Work
» Debate > Debate
» Poster Making
» Broacher making
Assessments | 1Al 1A 2
s PPT (May 2022) s PPT(November 2022)
1. From trade to territory 1. Mineral and power resources
2. Resources 2. The making of the national movement 1870s-1947
+ Oral Test % Oral Test
1. Understanding secularism, 1. Weavers, iron smelters and factory owners
2. The Indian Constitution 2. Law and Social Justice
Activities for Assessments Activities for Assessments
1. Tribals, Dikus and the Vision of a golden 1. Women, caste and reforms
age 2. Public facilities
2. How, When and Where
Syllabus for | Half Yearly Exams(September 2022) Annual Exams (March 2023)
Exams 1. Ruling the countryside 1. India after independence

2. When people rebel 1857 and after
3. Land, soils, water, natural vegetation

2. Civilizing the native educating the nation
3. Agriculture




and wildlife resources

4. Industries

5. Why do we need parliament

6. Understanding laws
Map Work
History: The main cities of the revolt 1857
Geography: Types of Soils, Iron and Steel
industries and major cotton textile industries

4. Human resources
5. Understanding of our criminal justice system
6. Judiciary

Map Work:
History: The making of national movement 1919 to 1947 -

Champaran, Chauri-Chaura, Amritsar, Ahmedabad, Lahore
and Dandi

Geography: Iron, Coal and Gold ( the three places of each
on political map of India)

The two least and most populated states of India.

The two states of each crops- Rice, Wheat, Tea, Coffee and
Sugarcane




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022-2023)
SUBJECT - SCIENCE

CLASS - VIII
April- August October- February

CONTENT 1. Chemical Effects of Electric Current 1. Materials: Metals and Non-metals

2. Cell-Structure and Functions 2. Sound

3. Force and Pressure 3. Micro-Organisms: Friend and Foe

4. Synthetic Fibres and Plastics(Activity) 4. Pollution of Air and Water

5. Light 5. Some Natural Phenomena

6. Coal and Petroleum (Activity) 6. Crop Production and Management(Activity)

7. Combustion and Flame 7. Conservation of Plants and Animals (Activity)

8. Reproduction in Animals 8. Friction

9. Reaching the Age of Adolescence 9. Stars and the Solar System
SUBTOPICS/ 1. Chemical effects of Electric Current 1. Materials :Metals and Non-metals
CONCEPTS % 1-20 elements: Name, Symbol, Atomic % Metals and non-metals: Occurrence, Physical and Chemical

Number, Electronic Configuration, Valence
electrons and Valency

Formula making

General balancing of equation
Conducting Property

Chemical effects of electric current
Electroplating

2. Cell-Structure and functions

++ Biodiversity around us

+«» Types of cell and cell structure

¢ Cell organelles

+«+ Cell division and growth

3. Force and pressure

+«» Different types of force

% Effects of force

+ Usage of force

K/ 7/ K/
LXCEIR X X4

X3

S

X/
L X4

Properties and uses
%+ Occurrence of non-metals
+«» Corrosion of metals and prevention
s Alloy
2. Sound
¢+ Cause of sound production
+» Propagation of sound
++ Characteristics of sound
¢ Types of sound
+«* Noise pollution and its causes and preventive measures
3. Microorganisms: Friend and Foe

X/

¢+ Characteristics features and importance of microorganisms

X/

+¢ Classification of microorganisms
¢+ Useful and harmful microorganisms
+«+ Food preservation

¢+ Nitrogen cycle




% Pressure

 Atmospheric pressure and its applications
4.Synthetic Fibres and Plastics(Activity)

%+ Synthetic fibres types and their properties
+ Plastic

5. Light

+ Reflection of light and its types

% Laws of reflection

+«+ Characteristics of image formation
Structure of eye and vision defects

+«»+ Dispersion of light

6. Coal and Petroleum(Activity)

+«+ Natural resources: Types and Conservation
% Fossil Fuels: Types and Conservation
7.Combustion and Flame

%+ Combustion: Condition, Types and products
% Flame: Candle flame and its zones

% Fuel: Efficiency and Harmful Effects

8. Reproduction in Animals

Reproduction in animals

Reproduction in human beings

Sex determination

Endocrine system

% Reproductive health and personal hygiene
9. Reaching the Age of Adolescence

« Puberty

s Secondary sexual characters

+« Endocrine glands

«» Hormones and their secretions

X/
LX)

>

K/ 7/ K/ 7/
RS IR X QI X 4

*

7/
*

4. Pollution of Air and Water

X/
o
X/
o

X/
°e

Pollutants
Air pollution
Water pollution

5. Some Natural Phenomena

X/
°e

X/
L X4

X/
°e

X/
L X4
X/

°

X/
L X4
X/

°

Properties of charges

Electroscope

Phenomenon of lightning

Lightning conductor

Cause and measurement of earthquake
Seismic zones in India

Precaution and protection during an earthquake

6. Crop production and Management(Activity)
7. Conservation of Plants and Animals (Activity)
8.Friction

*
L X4
X/
L X4
*
°

X/
L X4

Factors affecting friction

Causes of friction

Advantages and disadvantages of friction
Types of friction

9. Stars and the Solar System

X/
L X4

X/
°
X/

L X4

X/
°
X/

o

celestial objects
phases of the moon
Ursa major

Pole star

The solar system




SKILLS » Observational + Inferring
« Application « Communicating
» Diagrammatic + Evaluating
» Problem solving « Application
« Investigating * Investigating
« Synthesizing
ACTIVITIES e Classroom Activity e Lab Activities
e Lab Activities o Debate
e Slide Observation * Eefolr:)tIertlng
. ole Play
e Symposium * N 2
. . Field Vi
e Audio Visual Aids * Field Visit
ASSESSMENTS 1A1 1A2
« PPT (MAY 2022) + PPT (NOVEMBER 2022)
» Chemical effects of Electric current + Sound

Cell- Structure and Functions(diagrams
only)

Force and pressure

ORAL TEST (MAY)

Chemical effects of Electric current
Activities for Assessment

« Synthetic Fibres and Plastics

» Holidays Homework

 Minerals: Metals and Non-Metals

 Microorganisms: Friend and Foe, up to Protozoa
(Excluding Algae, virus, Food Preservation and Nitrogen
Cycle)

« ORAL TEST(OCTOBER)

« Pollution of Air and Water

*Activities for Assessment

Crop Production and Management

*Conservation of plants and animals




SYLLABUS
FOR EXAMS

HALF YEARLY EXAM( September 2022)

« Force and Pressure

e Cell- Structure and Functions

» Chemical Effects of Electric Current
« Light

» Combustion and Flame

« Reproduction in Animals

» Reaching the Age of Adolescence

ANNUAL EXAM ( MARCH 2023)
« Metals and Non-metals
« Sound
« Microorganisms: Friend and Foe
« Pollution of Air and Water
« Some Natural Phenomena
« Friction
+ Stars and the Solar System




CAMBRIDGE INTERNATIONAL SCHOOL
SYLLABUS (2022- 2023)

SUBJECT - ICT

CLASS- VI

April -August October - February

CONTENTS 1. Networking Concepts 1. More on Photoshop

2. Log on to Access 2. Statements in Python

3. Images, Links and Frames in HTML 5 3. lterative Statements

4. Learning Photoshop CS6 4. Cutting edge Technologies

5. Internet Safety

SUBTOPICS Networking Concepts Statements in Python

» Computer Networks » What are Control Statements?

» Types of Networks » Types of Control Statements

» Network Components Iterative Statements

» Network Architecture and Topology > Different Iterative Statements

» Network Security Cutting Edge-Technologies

Log on to Access
Types of Databases
Components of MS Access 2016
Starting Access 2016
Creating a Database
Views of a Table
Rules for Naming Fields
Data Types in Access
Adding Tables
Primary Key
Sorting a Table
Filtering Data
Searching in a Database
Closing Access 2016
Images, Links and Frames in HTML 5
» Inserting Images
» Linking Web Pages
» Inserting Audio and Video

VVVVVVVVVVVVYY

» Atrtificial Intelligence (Al)

» Augmented Reality (AR)

» Internet of Things (loT)

» Cloud Computing

» Big Data
Internet Safety
Data Privacy
Responsible Online Behavior
Online Banking Safety Measures
Safe Social Media Practices
E-Mail Courtesy

YVVVYY




> Frames and IFrames

Learning Photoshop CS6

Starting Adobe Photoshop CS6
Components of Adobe Photoshop CS6
Creating a New File

Inserting an Image

Opening an Image File

Saving and Closing File

Selection Tools

Move tool, Crop Tool and Slice Tool
Common Painting Tools

VVVVVVYVY

SKILLS

Listening, Critical thinking, Reasoning, Organizing,
Presenting, Self-Direction, Observation and Problem
Solving.

Listening, Critical thinking, Reasoning, Organizing,
Presenting, Observation and Problem Solving.

ACTIVITIES/LAB
WORK

» Make a collage on any scene such as

Jungle/Birthday party/visit to any historical place

using Photoshop

» Make 3 frames (with 2 different images and content

in one frame)

» Create any professional looking website on one of

the topics like Tourism company/Gym
center/Preparatory School

» Design a poster/cover page /Menu card of any
food outlet using Photoshop

» Performing Different Functions by using
Control Statements in Python

ASSESSMENTS

% 1A-1 (Topics/Chapters)
1. Networking Concepts
2. Log on to Access

«» ORAL TEST(Topic/Chapters)
1. Networking Concepts

« 1A-2 (Topics/Chapters)
1. Cutting Edge-Technologies
2. Internet Safety

«» ORAL TEST(Topic/Chapters)
1. Internet Safety




X/

« LAB Activities for Assessment
(Topics/Chapters)

1. Images, Links and Frames
2. Learning Photoshop CS6

« LAB Activities for Assessment
(Topics/Chapters)

1. Statements in Python
2. Iterative Statements

SYLLABUS FOR
EXAMS

HALF YEARLY EXAM (September 2022)

(Topics/Chapters)

1. Networking Concepts

2. Logon to Access

3. Images, Links and Frames
4. Learning Photoshop CS6

ANNUAL EXAM (March 2023)
(Topics/Chapters)

Cutting Edge-Technologies
Internet Safety

Statements in Python
Iterative Statements

Awnh e
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